# Table of Contents

**What is Medium?**  
11

**Getting Started with Medium**  
12

- Launching Medium  
  12
- Starting from Your PC  
  12
- Starting from the Oculus Home Screen  
  12
- Your Medium Workspace  
  13
- Tool Hand and Support Hand  
  14

**Using Medium: Sculpting Basics**  
15

- Adding Clay  
  15
- Undo and Redo  
  16
- Moving and Rotating Your Sculpt  
  16
- Pinch and Zoom  
  17
- Selecting Your Tool  
  18
- Switching Tool Modes  
  19
- Resizing Your Tool  
  20
  - Resize by Pushing/Pulling the Tool Hand Thumbstick  
    20
  - Resize by Depressing the Tool Hand Thumbstick Straight Down Along its Axis  
    21
- Tool Settings  
  22
- Tooltip Previews  
  23
- Defining an Alternate Tool  
  24

**Working with Medium Menus**  
25

- Interacting with Menus  
  25
- Moving Menus  
  26
- Closing a Menu  
  26

**Saving Your Work**  
27

**Favorites**  
28

**Starting a New Sculpt**  
29

**Loading a Saved Sculpt**  
30

**Medium Tools**  
31

- Clay  
  31
  - Adding Clay  
    31
  - Removing Clay  
    32
  - Setting the Clay Tool’s Size  
    33
  - Selecting a Clay Color  
    33
Clay Settings Menu
   Selecting the Clay Tool’s Shape 34
   Apply 34
   Size 34
   Stroke Type 34
   Stroke Taper 34
   Stroke Taper Speed 34
   Steady Stroke 36
   Constrain 36

Move 37
   Selecting the Move Tool 39
   Setting the Move Tool’s Size 39
Move Settings Menu 39
   Mode 39
   Layers 40
   Size 40
   Inner Radius 40
   Strength 40

Swirl 40
   Selecting the Swirl Tool 41
   Setting the Swirl Tool’s Size 41
Swirl Settings Menu 42
   Size 42
   Strength 42
   Direction 42

Flatten 42
   Selecting the Flatten Tool 43
   Setting the Flatten Tool’s Size 43
Flatten Settings Menu 44
   Size 44
   Hardness 44
   Constrain 44

Cut 45
   Selecting the Cut Tool 45
   Setting the Cut Tool’s Size (Length) 45
Cut Settings Menu 46
   Size 46
   Apply To 46
   Constrain 46
Inflate
  Selecting the Inflate Tool
  Setting the Inflate Tool’s Size
  Inflate Settings Menu
    Size
    Strength
    Apply
    Steady Stroke
    Constrain

Smooth
  Selecting the Smooth Tool
  Setting the Smooth Tool’s Size
  Smooth Settings Menu
    Size
    Strength
    Mode
    Steady Stroke
    Constrain

Paint
  Selecting the Paint Tool
  Setting the Paint Tool’s Size
  Selecting a Paint Mode
    Spray Mode
    Brush Mode
  Paint Settings Menu
    Size
    Opacity
    Hardness
    Apply
    Steady Stroke
    Constrain

Using Medium: Special Sculpting Modes
  Mirror Mode
    Mirror Settings
      Position
      Center Sculpt Origin
      Hiding the Mirror Plane
  Lathe
Using the Lathe to Review Your Work 58
Adding Rotational Shapes with the Lathe 59
Using a Tool While Turning Your Sculpt 59
Repositioning the Lathe 60
Lathe Settings 61
  Enabled 61
  Speed 61
  Direction 61
  Center Sculpt Origin 61
Angle Snap 61
Grid Snap 64

The Scene Graph, the Add Menu and the Action Menu 67
The Scene Graph: What’s in Your Scene? 69
  Scene Graph: Selecting a Single Element 70
  Scene Graph: Selecting Multiple Elements 71
  Scene Graph: Selecting Elements Directly in the Scene 73
  Scene Graph: Toggling Visibility of Elements in Your Scene 74
  Scene Graph: Renaming Elements in Your Scene 74
  Scene Graph: Restructuring Elements in Your Scene 75
The Add Menu 78
  Adding Layers 78
  Adding Reference Meshes 78
    Recommendations for Reference Meshes 78
    Importing and Positioning a Reference Mesh 79
    Wireframe 80
    Copy to Clay 80
    Making the Mesh Move with Your Sculpt 81
    Deleting a Reference Mesh 81
  Adding Reference Images 81
    Making Reference Images Move with Your Sculpt 83
    Deleting a Reference Image 83
  Adding Lights 84
  Adding Transforms 84
The Action Menu 87
  Settings 88
  Transform Selected 89
  Show/Hide Selected 89
  Duplicate Selected 89
The Scene Settings Menu: Customizing Your Workspace

- Sun Brightness
- Sun Color
- Background Color
- Skybox
- Ground Plane
- Bloom
- Set as Default
- Reset to Default

Working with Layers

- Viewing Layers for the Current Sculpt
- Adding Layers
- Designating the Active Layer
  - Selecting the Active Layer from the Scene Graph
  - Selecting the Active Layer Interactively
- Hiding and Showing Layers
- Duplicating Layers
- Deleting Layers
- Renaming Layers
- Merging Layers
- Subtracting Layers
- Finding the Intersection Between Layers
- Flipping a Layer Across the Mirror Plane
- Centering the Content of a Layer
- Increasing the Resolution of a Layer
- Decreasing the Resolution of a Layer
- Notes on Layer Resolution

Understanding Your Sculpt's Resolution

- When to Increase Your Sculpt's Resolution
- When to Decrease Your Sculpt's Resolution
- The Bounding Box

Working with Stamps

- Selecting a Stamp
  - Changing the Orientation of the Current Stamp
- Creating Your Own Stamps
  - Where Stamps are Saved
Transforming Elements in Medium

Transforms: Frame of Reference 129

Transforming Layers 129

Transforming a Layer Freehand 130
Transforming Multiple Layers Freehand 130
Selecting a Transform Operation for a Layer 131

Move Layers Freehand 132

Move Transform Settings Menu 132
Move Axis 132
Coordinate space 133
Snap 133

Rotate Layers Freehand 133

Rotate Transform Settings Menu 134
Rotation Axis 134
Coordinate space 134
Snap 134

Scale Layers Freehand 134

Scale Transform Settings Menu 135
Move Axis 135
Coordinate space 135
Snap 135

Setting the Pivot Point (Object Origin) for a Layer 136

Transforming Scene Elements 137

Reposition a Scene Element Freehand 137
Reposition a Scene Element with the Transform Menu 137
Translation Axes 138
Coordinate Space 138
Snap 138

The Control Panel 138

File 139
New 139
Quick Save 140
Save As... 142
Load... 142
Add Mesh as Clay... 142
Export... 143
Triangles 144
Paint 144
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notifications</td>
<td>164</td>
</tr>
<tr>
<td>User Preferences</td>
<td>164</td>
</tr>
<tr>
<td>Double Press Speed</td>
<td>165</td>
</tr>
<tr>
<td>First Time User</td>
<td>165</td>
</tr>
<tr>
<td>Tooltips</td>
<td>165</td>
</tr>
<tr>
<td>Application sounds</td>
<td>165</td>
</tr>
<tr>
<td>Controller vibration</td>
<td>165</td>
</tr>
<tr>
<td>Avatar Hands</td>
<td>165</td>
</tr>
<tr>
<td>Selecting a Hand</td>
<td>165</td>
</tr>
<tr>
<td>Exit Medium</td>
<td>166</td>
</tr>
</tbody>
</table>

Appendix A: Shortcuts  167
What is Medium?

Medium is a freeform 3D sculpting tool built for artists. Some of its most notable features include:

- **Organic and geometric modeling** - use Medium to craft both organic and geometric sculpts using a variety of customizable tools:
  - **Layers** - create different parts of your sculpt in discrete layers that can be modified and managed independently (or merged together).
  - **Stamps** - select from a library of custom shapes (or create your own) to add pre-defined, repeatable forms to your sculpt, or define your own custom “tool” through which to add clay.
  - **Mirror** - build models that are completely symmetrical.
  - **Color** - select a clay color as you work, or paint your sculpt with different brushes.
  - **Materials** - define surface attributes for individual layers.

- **Shared sculpt sessions** - make sculpting a social activity! Invite fellow artists to join a sculpting session when you want to share your work. Talk with each other and view the same content simultaneously to get immediate feedback.

- **Pipeline friendly** - Medium supports industry standard formats for both import and export:
  - **Import** - load 3D meshes from other packages directly into Medium, either as reference meshes to guide your work or to serve as the basis for your sculpting.
  - **Export** - save your sculpts for use with other applications or to generate 3D output.

- **Share your content** - share your 3D sculpts directly into your Facebook timeline and/or the Medium or Oculus websites.

- **Reference material** - place reference images, meshes, and videos into your workspace to help guide you.

- **Customizable workspace** - set lighting, background color, and other environmental preferences.

- **Record your work** - take photos, record videos, or capture entire VR sessions that can be shared or replayed.

- **Learning resources** - select from a variety of tutorials to help you learn Medium.
Getting Started with Medium

Launching Medium

Starting from Your PC

To get started with Medium from your PC:

1. Start Oculus on your PC.
2. Select Medium from your library.
3. Put on your Oculus headset.

Starting from the Oculus Home Screen

To get started with Medium from the Oculus Home screen:

1. Put on your headset and start Oculus if prompted.
2. After your Oculus Home screen loads, select the Library icon to see your currently installed games and apps.
3. Select Medium.

Note: Once you’ve used Medium, you may also see it listed under the recently used games and apps category on the Oculus Home screen.
Your Medium Workspace

When Medium opens, you’ll see a brief introductory sequence letting you know you’re in Medium.

The first time you use Medium, you’re asked whether you’re right handed or left handed. Select the hand that you would use to hold a sculpting tool as your dominant hand.

Once you’ve chosen, you can start sculpting right away or check out the tutorials (recommended for first timers):
If you choose to start sculpting, you’ll see your Tool hand and Support hand.

If you choose the tutorials route, the first tutorial loads automatically...follow along! (You can always re-watch the tutorials later.)

With either selection, you’ll see the same basic environment. Below the sphere, you’ll see a grid called the ground plane, and a surrounding cloud-covered half-dome called the skybox. (Later, you can customize your scene settings to turn off some of these visual elements, adjust your lighting, and so forth.)

Tool Hand and Support Hand

You sculpt in Medium using your controllers. Each Oculus controller is represented in Medium as one of your virtual hands, and each hand has a different function.

If you’re right handed:

- Your right hand is your Tool hand. You use your Tool hand to add clay to your sculpt or modify it using any of Medium’s tools, to select options from a menu, or select a layer in your scene.
- Your left hand is your Support hand. You use your Support hand to help do things like move your model and open menus.

If you’re left-handed (or if it just feels more natural), you can swap the function of your hands. Your preference for right or left-handedness is preserved between sessions. See Selecting a Hand if you want to change your preference for which hand is dominant.
Using Medium: Sculpting Basics

Adding Clay

Let’s start by adding some clay to your scene. The Clay tool is selected by default when you start Medium, so you should be good to go:

1. Squeeze the Tool hand trigger and move your hand.

As you move your Tool hand, a “trail” of clay flows from the tool.

2. Release the trigger to stop the flow.

3. Squeeze your Support hand grip button to move or rotate your sculpt and see it from different angles.
Undo and Redo

As you add clay (or perform other operations with different tools), you’ll inevitably make some mistakes. To step backward and forward through your actions:

- **Undo** - move the Support hand thumbstick left to undo the previous action.
- **Redo** - move the Support hand thumbstick right to reverse the previous undo action.

![Left, original sculpt; center, using the Move tool; right, move Support hand thumbstick left to undo](image)

You can undo and redo multiple actions by repeating the gestures described above.

Moving and Rotating Your Sculpt

As you work in Medium, you’ll get used to “picking up” your model and adjusting its position and orientation relative to the camera. This makes it easier to:

- Better see your sculpt’s silhouette and edge contours. As you work, it’s a good idea to constantly move your sculpt to better see its shape.
- Use a more natural stroke direction (that is, going from left to right or right to left) when you’re sculpting. In the same way an artist moves his sketch pad while sketching in 2D, moving your sculpt makes it possible to use a consistent, comfortable stroke.
- Orient your model so that the current tool has the effect you want. Some tools (like Smooth) need a direct “line of sight” to the surface of the sculpt. You may need to reposition your sculpt if the area you want to work on “line of sight” for the current tool is obscured by an intervening volume of clay.
- Move your sculpt in and out of the area of effect of the current tool (as you might move a marshmallow in and out of the flames of a campfire).
To adjust the position or orientation of your sculpt:

1. Squeeze and hold the grip button on your Support hand.
2. Move or rotate your Support hand in any direction.
3. Release the Support hand grip button when the sculpt is where you want it.

**Note:** You can also use the grip button on your Tool hand to move or rotate the sculpt; however, if you are actively working, you’ll probably find it easier to move your sculpt with your Support hand, and actively sculpt with your Tool hand.

**Pinch and Zoom**

You can also use a “pinch and zoom” motion to move the camera closer or further from your sculpt. You might zoom out to get a broader view of your model, or zoom in on an area where you need to add detail. Get used to climbing right into your dragon’s mouth to work on its teeth!

- Squeeze both of the grip buttons and move the controllers away from each other to zoom in on your sculpt, pulling it closer.
- Squeeze both of the grip buttons and move the controllers toward each other to zoom out from your sculpt, pushing it further away.

**Note:** Your tool size changes relative to your pinch and zoom actions, so you don’t need to resize your tool every time you adjust your point of view.
Selecting Your Tool

While each session starts with the Clay tool selected, Medium features an entire palette of tools. To select a different tool:

1. Push your Support hand thumbstick away from you to open the Tool Tray.

2. Aim the Tool hand at the pie-shaped wedge that holds the tool you want to use.

3. Squeeze the trigger on your Tool hand to select the tool.

**Note:** The rectangular Sculpting Modes menu below the Tool Tray is described later.

The tool preview changes to let you know that you’ve selected the new tool. Each tool has a different tool preview. You’ll get familiar with what each tool looks like the more you use Medium.

*Left to right: Clay tool, Smooth tool, and Paint tool*
Switching Tool Modes

Some sculpting tools have multiple *modes*. For example, if you select the Clay tool, you can switch between modes that let you either *add* or *subtract* clay.

To switch between modes for the current tool:

- Double tap the Gear button on your Tool hand.

If there are multiple modes, the Tool preview changes for each mode. For example, if you are adding clay, the preview is green, while if you are removing clay, it is red:

1. Select the Clay tool.
2. Add some clay to your scene.
3. Tap the Gear button on the Tool hand to switch modes. The Tool preview changes to a red color:
4. Squeeze the trigger on the Tool hand and move the tool over part of your sculpt to remove it.

**Note:** Not all tools have multiple modes. If there is only one mode for a tool, the double tap gesture has no effect. See the Medium Tools section for more information on alternate modes for specific tools.

**Resizing Your Tool**

You can change the size of your tool to better fit the scale of the sculpt or the action you want to perform. For example, you might want to increase the size of the Clay tool when you’re blocking in the volume of a sculpt, then decrease its size when adding finer detail.

There are two gestures for resizing the current tool:

**Resize by Pushing/Pulling the Tool Hand Thumbstick**

After selecting your tool:

1. Push the Tool hand thumbstick away from you to make the tool larger or pull it toward you to make the tool smaller. A green scale appears over your tool hand, indicating the tool’s relative size, and the tool preview changes size as you move the thumbstick.
2. Release the thumbstick to set the new tool size.

Resize by Depressing the Tool Hand Thumbstick Straight Down Along its Axis

For some tools (Clay, Move, Swirl and Flatten), you can also resize the tool by setting an anchor point and then moving your Tool hand:

1. Depress the Tool hand thumbstick, straight down along its axis, and keep it depressed, to set the anchor point. The tool preview (which is different for each tool) changes to yellow.

2. Move your Tool hand in any direction away from the anchor point to set the new tool diameter.
3. Release the thumbstick to set the new tool size.
Tool Settings

For most tools, you can set additional parameters that define how the tool works. For example, if you have the Clay tool selected:

- Tap the Gear button on the Tool hand to open the Clay settings menu.

Any sculpts in your scene are made semi-transparent and a menu appears in your scene, with a number of options related to how the current tool works.

The Clay settings menu lets you set things like the shape and size of the tool, tapering and constraint preferences, and so forth. The settings menu for every tool is described in the Medium Tools section.

**Note:** You can move the menu by pointing at it with your Tool hand, then squeezing the Tool hand grip button and moving your tool hand.
Tooltip Previews

For most menus in Medium, you can display short tooltips that describe what each setting does. In addition, the tooltip shows a brief animation of the effect of the setting or tool you’re hovering over:

When you stop pointing at the option, the tooltip (and the video) both disappear. You can turn this feature on or off in the User Preferences menu.
Defining an Alternate Tool

Once you start sculpting, you may get into a groove where you find yourself switching back and forth between two tools (for example, using Clay to build out your volume and Smooth to refine its surface). In Medium, you can define a primary and an “alternate tool” (or “alt-tool”) and switch between the two tools with a simple gesture:

1. First, make sure your “primary” tool is selected.
2. Press your Support hand thumbstick away from you to open the Tool Tray.
3. While the Tool Tray is open, point to a tool, and squeeze the Support hand trigger to select it as the alt-tool. A pink triangle appears on the Tool Tray next to the selected tool:

![Smooth tool selected as alt-tool](image)

To switch to the alternate tool while sculpting:

1. Squeeze and hold the Support hand trigger. (Note that the tool preview on the Tool hand changes to that of the selected alt-tool)
2. Use the Tool hand as you normally would.
3. Release the Support hand trigger to return to using the primary tool.
Working with Medium Menus

In some cases, you’ll need to tell Medium what you want to do, or change the settings for a tool. Menus are panels that appear in your workspace when you tap certain buttons on your controllers. For example, if you tap the Gear icon on your Tool hand, the Settings menu for that tool appears:

![Settings menu for Clay tool](image)

**Settings menu for Clay tool**

Interacting with Menus

To interact with a menu aim your Tool hand at the option on the menu you want to change and squeeze the Tool hand trigger:

- For sliders, *hold* the trigger while you drag the handle either left or right.
- Aim at the “-” and “+” symbols to decrement or increment the displayed value.
- Aim at the value itself to bring up a numeric keypad (for specifying exact values).
- For options that toggle on and off, aim at the option itself.
Moving Menus

Many of Medium’s menus can be moved. If you’re sculpting and you find that your view is obscured by a menu:

1. Aim the Tool hand at the menu.
2. Squeeze and hold the Grip button on the Tool hand.
3. Move the menu to its new position and release the Grip button.

Moving a menu: left, menu obscuring the sculpt, and right, after moving with Tool hand Grip button

Closing a Menu

There are a number of ways to close a menu in Medium, depending on its type:

- For most menus, you can simply aim the tool hand away from the menu and it will disappear. This is also called "waving off" the menu.
- For menus with an “X” in the upper left or right corner, aim at the “X” with your Tool hand and squeeze the Tool hand trigger. You cannot wave off a “menu” with an “X” in its corner.

Some special menus have specific “closing” behaviors:

- The Control Panel stays visible only as long as you press and hold the yellow Control Panel button on the Support hand. Releasing the button dismisses the menu.
- The Tool Tray stays visible only as long as you push the Support hand thumbstick away from you.
Saving Your Work

After you’ve done some sculpting, you can save your work.

1. Tap the yellow Control Panel button on your Support hand.
2. Select File > Quick Save.

If you loaded your sculpt from disk, Quick Save re-saves your work under the last specified filename, in the same directory. However, if this is the first time you’re saving, the Save Sculpt panel opens:

3. Using the file selector on the left, choose the directory where you want to save the sculpt.
4. Select the “Untitled” bar at the bottom of the panel and enter a name for the sculpt on the virtual keyboard that appears:

Medium inserts the name “Untitled”, but you can modify the filename as you see fit:

- Use either hand to point at keys on the keyboard.
- Squeeze the trigger on either hand to select (“press”) a key.

You can position the cursor by pointing and squeezing at a location inside the filename, or use any of the special keys on the keyboard:

- **Arrow** - deletes a character.
- **Clear** - clears the entire name.
- **Enter** - saves your sculpt with the specified filename.
- **+1** - increments the last digit in the filename. If the filename does not end in a number, a “1” is added (and can be incremented by repeating the gesture).

5. Select Save in the lower right corner of the Save Sculpt panel.

Once you’ve saved your work (or if you’re working on a sculpt you’ve loaded into Medium), the Quick Save option saves the sculpt with the previously specified filename in its original directory. If you want to save your work under a different filename or location, choose the **Save As** command.

**Notes:**

You can also:

- **Export your sculpt** in various industry-standard formats.
- **Share your sculpt** with others on Oculus.com or directly in Facebook.
Favorites

Whenever you are in the file selector, you can make any folder a favorite by clicking the star icon to the left of the directory. When the file selector is open (for any file, save, import or export operation):

1. Hover over the directory you want to make a favorite.
2. Aim your Tool hand at the gray star and squeeze the Tool hand trigger.
3. The star turns green and the directory is added to your Favorites.
4. The directory is now selectable under your Favorites across sessions.

Favorite folders will appear under your Favorites section, and are maintained across sessions:

Left, unstarred folder; center, click star to add to favorites; right, folder now selectable under favorites (across sessions)

Starting a New Sculpt

As you work, you may want to discard your current sculpt and begin working on a new one. To start a new sculpt:

1. Tap the yellow Control Panel button on your Support hand.
2. Select File > New.

CAUTION: Starting a new sculpt wipes out your current sculpt, so Medium always asks you to confirm this action before you proceed. If you don't want to lose your work, make sure to save your current sculpt before starting a new one (using either Quick Save or Save As).
Loading a Saved Sculpt

If you previously saved a sculpt, and want to reload it:

1. Tap the yellow Control Panel button on your Support hand.
2. Select File > Load Sculpt.
3. Using the file selector, navigate to the directory containing your sculpt file.
4. Select the sculpt from the center portion of the Load Sculpt panel.
5. Select Load in the lower right corner of the Load Sculpt panel.

**CAUTION:** Loading a previously saved sculpt wipes out your current sculpt, so Medium warns you if you have current unsaved changes. You’ll be asked if you want to:

- **Ignore** - ignore the warning and continue loading the previously saved sculpt.
- **Save** - save your work in progress before loading.
- **Cancel** - cancel the load.

Make sure to save your current sculpt before loading a new one.

That’s it! You now know how to:

- Start Medium.
- Add or remove clay.
- Select a tool.
- Resize your tool.
- Change tool modes.
- Change tool settings.
- Save your work.
- Start a new sculpt.
- Load a previously saved sculpt.
Medium Tools

Medium includes an entire palette of tools, each with a specific function. Tools include:

- Clay
- Move
- Swirl
- Flatten
- Cut
- Inflate
- Smooth
- Paint

Clay

Use the Clay tool to add clay to your sculpt. The Clay tool is your default tool when you first start a Medium session, and can be used to build out the basic volume of your sculpt or to add different levels of detail.

By default, the Clay tool has a spherical shape; you can select from other pre-defined shapes (see Clay Settings) or create and use your own custom stamps. You can add clay with continuous strokes or place a single instance of the current stamp with each squeeze of the trigger (see Single vs. Continuous Mode).

To select the Clay tool from the Tool Tray:

1. Push the Support hand thumbstick away from you to open the Tool Tray.
2. Point to Clay with your Tool hand and squeeze the Tool hand trigger.

Adding Clay

With the Clay tool selected:

1. Squeeze and hold the trigger on your Tool hand. The trigger is pressure sensitive, so the harder you squeeze, the faster the clay “comes out” of the tool, just like a tube of toothpaste.
2. Move your Tool hand while holding the trigger to add clay just where you want it.
Removing Clay

You can also use the Clay tool to remove clay from your scene. With the Clay tool selected, double-tap the Settings button on your Tool hand to switch modes. The tool preview changes color from green to red; when in this mode, the tool removes clay instead of adding it.

To remove clay from your sculpt:

1. Press and hold the trigger on your hand. Just as when adding clay, the trigger is pressure sensitive, so the harder you squeeze, the more clay you remove.
2. Move your Tool hand while holding the trigger. The area where the tool preview intersects with your sculpt is removed.

Double-tap the Settings button on your Tool hand again to switch back to adding clay.
Setting the Clay Tool’s Size

You can change the Clay tool’s size to add more or less clay to your sculpt with each squeeze of the trigger...imagine a larger or smaller opening on a tube of toothpaste. You might use a larger size for adding primary volume to your sculpt, then reduce the size for adding secondary and tertiary levels of detail:

- Push the Tool hand thumbstick away from you to increase the Clay tool size.
- Pull the Tool hand thumbstick toward you to decrease the Clay tool size.

The tool preview changes gets larger or smaller, and a green scale appears over the tool hand to indicate the relative size of the tool.

Selecting a Clay Color

You can select the color of the clay you add to your sculpt. With the Clay tool selected:

1. Tap the Color button on the Tool hand.
2. To choose a color, do one of the following:
   - Aim the Tool hand at the color you want to use in the colorspace and squeeze the trigger to select.
   - Adjust the saturation and value sliders.
   - Adjust the RGB sliders.

You can select the clay color from either the Color Menu or directly from your model (see The Color Menu).
Notes:

- Clay color information is included when exporting sculpt with the vertex color information, but is not included when exporting textures. See Exporting Your Sculpt for more information.
- If you use more than one color in a single layer, many sculpting operations (such as Smooth or Inflate) will cause those colors to blend. If you are working on a complex sculpt where you want to give different parts their own colors (for example, make an alien’s head green, and its teeth white), you may want to consider breaking your work into layers.

Clay Settings Menu

With the Clay tool selected, press the Gear button on your Tool hand to open the Clay settings menu. Use the options on the Clay settings menu to define the size, shape, and behavior of the Clay tool as you sculpt.

Selecting the Clay Tool’s Shape

At the top of the menu, you can select from three default Clay tool shapes:

- Sphere
- Cube
- Capsule

In addition to these default shapes, you can select from Medium’s library of stamps (or one of your own that you’ve created previously) to define the Clay tool’s shape.

For more information, see stamps below.

Apply

Select the tool mode:

- Add - add clay when the trigger is pressed.
- Erase - remove clay when the trigger is pressed.

Size

Set the overall size of the Clay tool.
Stroke Type

Use the Stroke Type setting to determine how clay is added to your scene:

- **Continuous** (default) - add clay continuously as you squeeze the trigger, following the path of your stroke.
- **Single** - add a discrete instance of the shape with each squeeze of the trigger. You must release the trigger after each stamp to add a new instance.

Single mode is useful for:

- Adding repetitive detail to your sculpt (teeth, warts, bolts, etc.)
- Building inorganic shapes with hard surfaces (buildings, robots, etc.)

Stroke Taper

Defines the behavior for each clay stroke:

- **Thickness** - the stroke volume fills only from within the boundaries of the current stamp, as if you were “pouring” clay into its volume. Choose this option if you are using a stamp which has a negative space (a hole) in it.
- **Scale** - the stroke volume fills by scaling the stamp as needed with the stroke pressure. This option works better if your sculpt has a well-defined volume.
- **None** - each stroke adds clay using the full volume of the stamp, without any tapering.

Stroke Taper Speed

Controls how quickly the stroke tapers. If either Thickness or Scale are selected in the Stroke Taper section, choosing maximum speed makes the taper instantly matches trigger pressure; a lower value will act as a “throttle” on the taper effect.
Steady Stroke

If you’re trying to lay down a line of clay, but need to move the Clay tool slowly, the “jitter” effect (shown in the top shape at left) is accentuated. Enabling Steady Stroke causes clay to be added only when you move the tip of the tool beyond the edge of the white bounding sphere.

It may help to think of the white bounding sphere as a “rest area”; as long as you keep the tip of your tool within it, the tool effectively “pauses.”

Setting any radius turns the effect on; in general you probably want to make the bounding sphere slightly larger than your Clay tool size.

Note: Steady Stroke is calculation intensive, and can slow down the Clay tool. Use it as needed!

Constrain

Constrains the clay tool to move in a straight line, on a plane, or along the surface of your sculpt (great for adding surface detail):

- **Line** - add or remove clay along a straight line. When you select Line, a broken line tool preview appears, attached to the tool. When you squeeze the Tool hand trigger, the orientation of the line is “locked” and you add or remove clay only along that line. Release the trigger to re-orient the line. The Line constraint is useful, for example, when you need to add hard line shapes (rails, streets, etc.), or remove a channel along a flat surface.

- **Plane** - add or remove clay along a planar surface. When you select Grid, a two-axis preview appears, attached to your tool. When you squeeze the Tool hand trigger, the orientation of the grid is “locked” and you add or remove clay only on that plane. Release the trigger to re-orient the grid.

- **Surface** - add or remove clay along the surface of your sculpt. When you select Surface, aim the tool at the surface of your sculpt. When you squeeze the Tool hand trigger, clay is added or
removed along the surface. The Surface constraint is useful, for example, to add surface detail (veins, warts, or other textural details) to organic sculpts.

*Constraining the Clay tool to use Surface is a great way to add detail.*
Move

Use the Move tool to change the shape of clay that you have already added to your sculpt. You can use the Move tool to tweak the form of your sculpt by squashing, stretching, and rotating all or part of your sculpt.

The Move tool has two distinct modes:

- In its **default** mode, the Move tool consists of two concentric spheres centered around the Tool hand. Within the inner sphere, the move will have 100% effect; that effect falls off gradually to the boundary of the outer sphere. When you initiate the tool, the clay within those two spheres is “grabbed” and follows the tool:

- In its **elastic** mode, the Move tool shows just one sphere of influence; the area of effect moves with the tool, giving the move a more fluid or **elastic** effect:

**Notes:**

- You can select elastic mode from the **Move Settings** menu.
- By default, the Move tool affects all layers. To change this setting, select the Move tool and tap the Gear button on your Tool hand to open the Move tool Settings menu.
Selecting the Move Tool

To select the Move tool from the Tool Tray:

1. Push the Support hand thumbstick away from you to open the Tool Tray.
2. Point to Move with your Tool hand and squeeze the Tool hand trigger.

Setting the Move Tool’s Size

You can change the Move tool’s size so that it affects more or less of your sculpt as you work.

- Push the Tool hand thumbstick away from you to increase the Move tool size.
- Pull the Tool hand thumbstick toward you to decrease the Move tool size.

The tool preview changes, and a green scale appears over the tool hand to indicate the relative size of the tool.

In its default mode, the Move tool has both an inner and an outer radius. When you resize the tool as described above, you scale the overall size of the tool (both spheres). If you want to adjust the ratio of the inner sphere to the outer sphere, you’ll need to use the Move settings menu.

Move Settings Menu

With the Move tool selected, press the Gear button on your Tool hand to open the Move settings menu. Use the options on the Move settings menu to define the size, shape, and behavior of the Move tool as you sculpt.
Mode

Choose between the Move tool’s default mode or its elastic mode (both described above).

Layers

By default, the Move tool affects all layers of your sculpt. Select Active Layer Only if you want the move to affect only the layer you are currently sculpting.

Size

The overall radius of the Move tool.

Inner Radius

The ratio of the inner sphere to the outer sphere.

- The area inside the inner sphere moves 100%.
- For the area between the inner sphere and outer sphere, there is a smoothed falloff of effect; areas further from the inner sphere move less than those closer to it.

If you want to move a discrete part of your sculpt intact (for example, repositioning the contents of a layer relative to another), make sure the inner radius is large enough to surround the entire part you want to move.

Strength

The Strength option affects the overall behavior of the tool:

- A higher number causes the tool to have a “harder” effect (think “spike”).
- A lower number causes the tool to have a “softer” effect (think “bump”).
Swirl

Use the Swirl tool to rotate an area of your sculpt either clockwise or counter-clockwise and pull it away from the surface. The Swirl tool behaves a lot like one of the beaters on an electric mixer dipped into a bowl of dough.

Left, before swirl; center, clockwise swirl; right, counter-clockwise swirl.

Selecting the Swirl Tool

To select the Swirl tool from the Tool Tray:

1. Push the Support hand thumbstick away from you to open the Tool Tray.
2. Point to Swirl with your Tool hand and squeeze the Tool hand trigger.

Setting the Swirl Tool’s Size

You can change the Swirl tool’s size to affect more or less of your sculpt:

- Push the Tool hand thumbstick away from you to *increase* the Swirl tool size.
- Pull the Tool hand thumbstick toward you to *decrease* the Swirl tool size.
Swirl Settings Menu

With the Swirl tool selected, press the Gear button on your Tool hand to open the Swirl settings menu:

- **Size**
  - Set the size of the Swirl tool.

- **Strength**
  - The relative intensity of the swirl operation.
  - Higher values create a “swirlier” effect.

- **Direction**
  - Set the direction in which the clay swirls. The arrow on the tool preview changes to show the selected direction.
Flatten

The Flatten tool behaves much like a “sanding disk” that can grind down part of your sculpt. You can adjust the size of the disk, make it orient itself to your sculpt’s surface, and even set the hardness of the edges it produces.

Left, before flatten; center, flattening (with cylindrical preview); right, after flatten operation.

Selecting the Flatten Tool

To select the Flatten tool from the Tool Tray:

1. Push the Support hand thumbstick away from you to open the Tool Tray.
2. Point to Flatten with your Tool hand and squeeze the Tool hand trigger.

Setting the Flatten Tool’s Size

You can change the Flatten tool’s size to affect more or less of your sculpt:

- Push the Tool hand thumbstick away from you to increase the Flatten tool size.
- Pull the Tool hand thumbstick toward you to decrease the Flatten tool size.
Flatten Settings Menu

With the Flatten tool selected, press the Gear button on your Tool hand to open the Flatten settings menu:

**Size**

Set the diameter of the disk.

**Hardness**

Set the resulting edge hardness on the flattened area of your sculpt.

- Use a higher value to create a harder edge.

Use a lower value to create a softer, more beveled edge.

**Constrain**

Orients the sanding disk to the surface normals of the area at which you are pointing. You could use this setting, for example, to “grind down” areas of detail you want to remove:
Cut

Cuts your model into different parts. The cut does not have to be flat, but you can constrain it to a plane if you want to (see Constrain below). The Cut tool slices your sculpt into multiple pieces; each of those pieces becomes a new layer.

The tool is shaped like a wand; to make a cut, you must pass the wand entirely through a part of your sculpt, separating it from the rest of the model. After a short delay, the separated volumes are cut and placed on unique layers (for more information, see Layers).

Notes:

- If the cutting tool does not entirely separate part of an object (for example, if the wand does not extend all the way through the back of the sculpt when trying to cut), nothing occurs.
- By default, the Cut tool affects all layers. To change this setting, select the Cut tool and tap the Gear button on your Tool hand to open the Cut tool Settings menu.

Selecting the Cut Tool

To select the Cut tool from the Tool Tray:

1. Push the Support hand thumbstick away from you to open the Tool Tray.
2. Point to Cut with your Tool hand and squeeze the Tool hand trigger.

Setting the Cut Tool’s Size (Length)

You can change the Cut tool’s length to slice through more or less of your sculpt:

- Push the Tool hand thumbstick away from you to increase the Cut tool size (make it longer).
- Pull the Tool hand thumbstick toward you to decrease the Cut tool size (make it shorter).
Cut Settings Menu

With the Cut tool selected, press the Gear button on your Tool hand to open the Cut settings menu:

**Size**
The size (length) of the Cut tool.

**Apply To**
Specify which layers are affected by the cut tool.

- **All Layers** - cuts all layers in your sculpt.
- **Active Layer Only** - cuts only the current layer.

**Constrain**
Select Line to constrain the cut along a plane. If selected, the tool preview changes to a projected broken line which you can use to define the plane.

*Left, preview of line; middle, cutting plane; right, cut object.*
Inflate

The Inflate tool lets you expand a portion of your sculpt’s surface relative to its surrounding area, creating additional volume in your sculpt. This makes it ideal for tasks like accentuating bone ridges or muscles, or creating surface detail like warts or bumps.

Double tap the Gear button on your Tool hand to make this a Deflate tool. In Deflate mode, the tool can be used to create valleys, crevices or even holes in the surface of your sculpt. Flipping between modes (and adjusting the strength of the tool) is a great way to create surface contrast on your sculpt.

Left, original sculpt; center, inflate tool used on brow ridge; right, deflate tool used to sculpt out valley

Note: The Inflate tool can also be used to expand the clay surrounding an area of negative space to “fill in” holes that you might want to plug if you’re exporting your model for 3D printing.

Selecting the Inflate Tool

To select the Inflate tool from the Tool Tray:

1. Push the Support hand thumbstick away from you to open the Tool Tray.
2. Point to Inflate with your Tool hand and squeeze the Tool hand trigger.
Setting the Inflate Tool’s Size

You can change the Inflate tool’s size to affect more or less of your sculpt:

- Push the Tool hand thumbstick away from you to *increase* the Inflate tool size.
- Pull the Tool hand thumbstick toward you to *decrease* the Inflate tool size.

Inflate Settings Menu

With the Inflate tool selected, press the Gear button on your Tool hand to open the Inflate settings:

**Size**
Set the diameter of the Inflate tool.

**Strength**
Set the strength of the Inflate tool (higher values cause the clay to inflate/deflate more quickly).

**Apply**
Select the mode for the tool:

- **Inflate** - expands the surface area under the tool.
- **Deflate** - contracts the surface area under the tool

**Steady Stroke**
Reduce jitter by setting a diameter within which the inflate/deflate action is smoothed.

**Constrain**
Constrain the inflation or deflation to a straight line. A broken line tool preview appears, attached to the tool. When you squeeze the Tool hand trigger, the orientation of the line is “locked” and the inflation or deflation is constrained to that line. Release the trigger to re-orient the line.
Smooth

Use the Smooth tool to smooth out rough areas of surface topology on your sculpt, either by filling in valleys, flattening bumps, or both (selectable on the Settings menu). You can also adjust the size and strength of the Smooth tool.

Left, original sculpt; right, after smoothing

Selecting the Smooth Tool

To select the Smooth tool from the Tool Tray:

1. Push the Support hand thumbstick away from you to open the Tool Tray.
2. Point to Smooth with your Tool hand and squeeze the Tool hand trigger.
Setting the Smooth Tool’s Size

You can change the Smooth tool’s size to affect more or less of your sculpt:

- Push the Tool hand thumbstick away from you to *increase* the Smooth tool size.
- Pull the Tool hand thumbstick toward you to *decrease* the Smooth tool size.

Smooth Settings Menu

With the Smooth tool selected, press the Gear button on your Tool hand to open the Smooth settings menu:

![Smooth Settings Menu](image)

- **Size**
  - Set the size of the Smooth tool.

- **Strength**
  - Set the strength of the Smooth tool.

- **Mode**
  - **Fill** - smooth the sculpt’s surface by filling in valleys.
  - **Average** - smooth the sculpt’s surface using a combination of filling and flattening (essentially working toward the surface midpoint of the area under the tool).
  - **Flatten** - smooth the sculpt’s surface by flattening bumps or other protrusions.

**Steady Stroke**

Reduce jitter by setting a diameter within which the smooth action itself is smoothed.

**Constrain**

Constrain smoothing to a straight line.

- When you select Line, a broken line tool preview appears, attached to your tool. When you squeeze the Tool hand trigger, the orientation of the line is “locked” and the Smooth tool is constrained to movement along that line. Release the trigger to re-orient the line.
Paint

Apply color to the surface of your sculpt, either spraying the paint (like an airbrush) or directly to its surface (like a paintbrush). Both modes allow for pressure sensitive application of paint.

*Left, painting in brush mode; center, with airbrush; right, after using a combination of both modes*

**Note:** The level of detail you can paint onto the surface of your sculpt is constrained by the layer’s resolution. If you need to add more paint detail to a layer, consider increasing its resolution.

Selecting the Paint Tool

To select the Paint tool from the Tool Tray:

1. Push the Support hand thumbstick away from you to open the Tool Tray.
2. Point to Paint with your Tool hand and squeeze the Tool hand trigger.

Setting the Paint Tool’s Size

You can change the Paint tool’s size so that it colors more or less of your sculpt’s surface:

- Push the Tool hand thumbstick away from you to *increase* the Paint tool size.
- Pull the Tool hand thumbstick toward you to *decrease* the Paint tool size.

Selecting a Paint Mode

By default, the paint tool starts out in airbrush mode. With the paint tool selected, double tap the Settings button to switch to paintbrush mode, and again to switch back.
**Spray Mode**

In spray mode, the paint tool works like an airbrush. When you aim the tool at your sculpt, a green circle shows you where the paint will be applied.

1. Tap the color button to select a paint color.
2. Point the brush at the surface of your sculpt.
3. Squeeze the trigger on your Tool hand to paint the model’s surface. The tool is pressure sensitive, so squeezing the trigger harder applies more paint.

**Note:** Use the Paint settings menu to make further refinements to the tool.

**Brush Mode**

In brush mode, the paint tool works more like a paintbrush. The brush applies the selected color to the surface with the same pressure sensitivity effect of the airbrush mode; however, only clay within the tool’s sphere of influence is affected.

**Paint Settings Menu**

With the Paint tool selected, press the Gear button on your Tool hand to open the Paint settings menu:

- **Size**
  - Set the diameter of the tool.

- **Opacity**
  - Set the opacity for the color being applied to the sculpt’s surface. A higher value will make the color appear more solid.

- **Hardness**
  - Set the edge treatment for the paint tool. A higher value creates a shaper line at the edge of the area being painted, while a lower value creates a falloff effect.
Apply

Select the mode for the Paint tool:

- **Spray** - sprays the color onto the sculpt, like an airbrush.
- **Brush** - applies the color directly to the surface of the sculpt, like a paintbrush.

Steady Stroke

Reduce jitter by setting a diameter within which the paint stroke is smoothed.

Constrain

Constrain painting to a straight line. A broken line tool preview appears, attached to the tool. When you squeeze the Tool hand trigger, the orientation of the line is “locked” and your paintbrush or airbrush are constrained to movement along that line. Release the trigger to re-orient the line. The Line constraint is useful, for example, when you need to paint stripes or other lines on your sculpt.
Using Medium: Special Sculpting Modes

In addition to freehand sculpting, Medium supports several special sculpting modes:

- Mirror
- Lathe
- Angle Snap
- Grid Snap

These modes are displayed directly under the Tools Tray, on the Sculpting Modes menu:

To select a special sculpting mode:

1. Push the Support hand thumbstick away from you.
2. Aim the Tool hand at the special mode(s) you want to use and squeeze the trigger.

**Note:** You can use more than one special sculpting mode at the same time; for example, you might use the Mirror and Grid Snap mode together to create similar lattices on both sides of a starship. You can also use these options with the Constrain options available for various tools, as described below.
Mirror Mode

Medium’s Mirror feature lets you sculpt on one “side” of your model and see those changes “reflected” or “mirrored” across a plane, resulting in a perfectly symmetrical sculpt with only half the work. You can start your session with Mirror mode enabled (to get the basic form down in a symmetrical fashion) and then turn Mirror mode off to apply changes to one side (such as repositioning a limb or adding asymmetrical surface detail).

To enable Mirror mode:

1. Push the Support hand thumbstick away from you.
2. Select Mirror.

When you enable Mirror mode, the position of the mirror plane is indicated by four corners with a set of crosshairs at its center.

The mirror effect is applied regardless of the tool you select, or the selected tool mode (for example, you can either add or remove clay in a mirrored fashion, or paint both the near and far sides of your model simultaneously). When you aim a tool at the sculpt, you’ll see a counterpart “ghost” image of the tool aimed at the corresponding location on the other side of the mirror plane.

Try it out:

1. Select the Clay tool.
2. As you move your tool hand, a corresponding “ghost” tool preview appears at the corresponding location of the model on the other side of the mirror plane.
3. Add some clay to one side of the mirror plane. Note that it’s automatically applied in a “reflected” fashion onto the other side:

![Left, clay tool with mirror preview on opposite side; right, clay applied symmetrically to active layer](image)

**Mirror Settings**

You can use the Mirror settings menu to save or restore the mirror plane’s position, or align your sculpt’s origin to the mirror plane.

To open the Mirror Plane settings menu:

1. Pull the Support hand thumbstick toward you.
2. Open the Scene Graph.
3. Select the Mirror Plane node in the Scene Graph. You can enable or disable the Mirror Plane on the Action Menu; additional settings are available on the Settings menu (described below).

Select any of the following options:

**Position**

Save or restore the position of the mirror plane:

- **Set to saved** - restores the mirror plane to your previously saved position.
- **Save** - save the mirror plane’s current position as your preferred position.
- **Reset** - restores the mirror plane to the factory default position.
Center Sculpt Origin

Aligns your sculpt’s origin to the center of the mirror plane. The origin is aligned such that the +Z axis is pointing “up” toward the top of the mirror plane (with the ZY plane of the sculpt aligned to the mirror plane).

Hiding the Mirror Plane

If you want to use the Mirror plane, but don’t want to be distracted by it while you’re sculpting, you can hide it using the Scene Graph:

1. Pull the support hand thumbstick toward you.
2. Open the Scene Graph.
3. Toggle the visibility of the Scene Graph node.

The Mirror Plane will still be in effect but no longer be visible.
Lathe

The lathe feature rotates your sculpt as if it were sitting on a potter’s wheel. Just like the potter’s wheel, you can use the lathe to:

- Review your work in progress from different angles.
- Use any of Medium’s tools on the sculpt while it’s spinning (such as painting your sculpt)
- Add “spiral” features while sculpting.
- Capture short video previews of your work to share with friends, clients, or on social media.

Using the Lathe to Review Your Work

The simplest use of the lathe is as a simple way to review your work.

To start the lathe:

1. Push the Support hand thumbstick away from you.
2. Select Lathe. Your sculpt begins to rotate, giving you a 360-degree view of your work.

To stop the lathe:

3. Push the Support hand thumbstick away from you.
4. Select Lathe again.
Adding Rotational Shapes with the Lathe

You can also take advantage of the lathe’s rotation to add circular or spiral shapes with the Clay tool.

1. Start the lathe as described above.
2. Select the Clay tool.
3. Squeeze and hold the Tool hand trigger in place while the lathe spins to create a ‘donut’ shape (a torus):

![Image of a torus shape created on a lathe.]

**Note:** To get a perfect torus, enable Steady Stroke on the Clay tool Settings menu.

Using a Tool While Turning Your Sculpt

Your tools still remain in effect when the lathe is spinning, so you can take advantage of its rotation to apply effects to the entire model. For example:

1. Start the lathe as described above.
2. Select the Inflate tool.
3. Aim the Inflate tool at the model and squeeze the Tool hand trigger.

![Image of a sculpt with an inflate tool applied.]

In this scenario, the sculpt rotates under the Inflate tool, creating a ridge in the surface as it moves under the tool.

You can use any tool while the lathe is rotating (for example, you might use the Smooth tool as your sculpt rotates to smooth all sides of your sculpt equally or to paint its entire surface).
Repositioning the Lathe

You can reposition of the lathe (as if you were moving the potter’s wheel to a different location in your studio):

1. Pull the Support hand thumbstick toward you.
2. Aim your Tool hand at the lathe and squeeze the Tool hand trigger to select the Lathe (which pauses temporarily):

3. Squeeze either of the Grip buttons and move the Lathe to a new position on the ground plane:

4. Pull the thumbstick on your Support hand toward you to restart the Lathe.
Lathe Settings

You can change the speed and direction of the lathe on the Lathe Settings menu:

1. Pull the thumbstick on your Support hand toward you.
2. Select the Lathe using one of these two methods:
   ○ Open the Scene Graph and select the Lathe node.
   -or-
   ○ Aim your Tool hand at the lathe and squeeze the Tool hand trigger.
3. On the actions menu, choose the settings menu (gear icon).

The Lathe settings menu opens:

- **Enabled**
  Indicates whether the lathe is on or off.

- **Speed**
  The speed at which the lathe rotates. Higher values rotate faster.

- **Direction**
  The direction (clockwise or counterclockwise) in which the lathe turns.

- **Center Sculpt Origin**
  Aligns the sculpt’s (object) origin over the lathe (along its Z axis). For more information on transforms like this, see *Applying Transforms to Your Sculpt*. 

-61-
Angle Snap

Angle Snap lets you constrain the orientation of the current tool to a specific angle increment, relative to either the layer or the sculpt origin.

For example, with the Clay tool, if you set the Angle Snap to 90°, you could create perfectly perpendicular walls for a building:

1. Select a stamp.
2. Push the Support hand thumbstick away from you.
3. Select Angle Snap on the sculpting modes menu:

   ![Sculpting modes menu with Angle Snap selected]

4. Initially, leave the angle at 90°.

   The angle can be specified relative to either the active layer or to the sculpt’s origin. (If you’ve rotated a layer so that its origin is different than the sculpt’s you may want to use Orient to Layer.)

5. When enabled, you’ll see a set of three-dimensional axes appear over the tool.
6. Use the stamp to lay down the first wall:
7. Reorient your tool hand so that the stamp preview ‘snaps’ perpendicular to the first wall, then add the second wall:

8. Continue adding sections to your building:

If you decide that you need to be able to work in, say 45° increment, you can change the value in the Angle Snap settings. After making the change, you can now orient your tool in 45° increments:
To turn off Angle Snap:

9. Push the Support hand thumbstick away from you.
10. Select Angle Snap again.

Notes:

● Angle Snap and Grid Snap can be used together if you want to constrain the orientation of the stamp to regular intervals when it’s applied to the grid point.
● Angle Snap can be used with the Mirror Plane. Any clay added to one side of the plane is added in its mirror location on the other side.
Grid Snap

Grid Snap constrains movement of the current tool among a set of specific points in space. The location and distance between the points can be specified in increments that are relative to either the layer or the sculpt origin.

1. Push the Support hand thumbstick away from you.
2. Select Grid Snap on the sculpting modes menu:

Once enabled, a lattice of 3D points appears in your scene.

When using Grid Snap with the sphere stamp selected (the Clay tool’s default shape) you can apply clay between the segments that join any two grid points. You might use this technique to build up a lattice:

Note. Adding clay along the segments between nodes in the 3D grid is supported only when using the sphere stamp.

You can use this technique to create any shapes that are made up only of segments:
When using Grid Snap with any stamp other than the sphere, clay can only be applied directly on the grid points (but not between). Note that the tool’s orientation is not constrained, only its position. This means that even though the tool ‘jumps’ to each node in the 3D grid, you can still orient the tool around each point:

To turn off Grid Snap:

1. Push the Support hand thumbstick away from you.
2. Select Grid Snap again.

Notes:

- Angle Snap and Grid Snap can be used together if you want to constrain the orientation of the stamp to regular intervals when it’s applied to the grid point.
- Grid Snap can be used with the Mirror Plane. Any clay added to one side of the plane is added in its mirror location on the other side.
The Scene Graph, the Add Menu and the Action Menu

As you continue sculpting, you may want to add new elements such as additional layers, lights, and so forth. You can manage the contents of your scene and perform various actions using a trio of menus that you’ll become very familiar with:

- The Scene Graph
- The Add menu
- The Action menu

To open (or close) this trio of menus, pull the Support hand thumbstick toward you:
The **Scene Graph** lets you view and manage the contents of your scene. You can:

- View the *contents* of your scene.
- View the *hierarchy* of elements in your scene (parent-child relationships).
- *Modify* the hierarchy of elements in your scene, creating parent child relationships with multi-select and drag-and-drop.
- Toggle *visibility* of elements in your scene.
- Select one or more elements on which you want to perform an *action* (e.g., select layers to combine).
- *Rename* elements in your scene.
- *Delete* elements from your scene.

The Scene Graph can be repositioned like any other menu in Medium...just aim your Tool hand trigger at its border, squeeze the grip button and move your controller.

The **Add menu** lets you add new elements to your scene, including:

- **Layer** - add additional layers to hold discrete areas of your sculpt.
- **Reference Mesh** - import a 3D mesh into your scene.
- **Reference Image** - position one or more reference images.
- **Light** - add either spot or point lights.
- **Transform** - add arbitrary transforms as needed to support the structure of your sculpt.

The Add menu appears directly over your Support hand.

The **Action menu** opens only after you select an element in the Scene Graph or from the scene. The options available on the Action menu change depending on the type and number of element(s) you have selected. However, the general actions that you can perform include:

- **Settings** - open the Settings menu for the selected element, defining how it works (as for the Mirror plane) or its attributes (as for a spot light).
- **Transform** - open the Transform menu for the selected elements.
- **Duplicate** - make a copy of the element(s).
- **Delete** - remove the element(s) from the scene.
- **Element Specific Actions** - the lower portion of the panel displays additional options that may be available for the selected element (such as enabling/disabling).

Each of these menus—Scene Graph, Add, and Action—is described in more detail in the sections that follow.
The Scene Graph: What’s in Your Scene?

The most basic use of the Scene Graph is to see a catalog of all the elements in your scene. The Scene Graph includes both elements that have been added by Medium and elements you have created yourself:

You need to select one or more elements in order for the Action menu to appear.
Scene Graph: Selecting a Single Element

In order to perform an action on an element, you need to select it. To select a single element in the Scene Graph:

1. Pull your Support hand thumbstick toward you to open the Scene Graph.
2. Aim your Tool hand directly at the node and squeeze the trigger, or aim at the check box next to the node.

When you select an element, a check mark appears in the checkbox next to its node, and a thin blue box appears around its node in the hierarchy. The Action menu (described below) opens, showing the available actions you can perform on the element.

Note: The active layer is always highlighted in green. This is the layer into which any new clay is applied. Selecting a single layer in the Scene Graph makes it the active layer.
Scene Graph: Selecting Multiple Elements

Sometimes, you need to select multiple elements in the Scene Graph, either to perform a common action on them (such as duplicating or deleting), or to perform an action that requires multiple elements (such as merging two layers into one). To select multiple elements in the Scene Graph:

1. Pull your Support hand thumbstick toward you to open the Scene Graph.
2. Aim your Tool hand directly at the node and squeeze the trigger to select the first element.
3. Squeeze and hold the Support hand grip button, then select additional elements. Medium draws a thin blue box around each element as it is selected.

As you select additional elements, the options available on the Action menu update dynamically to show only the options that can be performed on all the selected elements.

For example, if you select multiple layers, the Action menu looks something like this:
When multiple elements are selected on the Scene Graph, the one you chose first appears on the Action menu. In the example above, while both “Layer 1” and “Layer 2” were selected, “Layer 1” was selected first. For some operations (such as Subtract), the order is significant (see below).

Note:

- The active layer is always highlighted in green. This is the layer into which any new clay is applied. When selecting multiple layers, the first layer selected in the Scene Graph becomes the active layer.
- If you select multiple layers and choose the Settings icon to edit Materials attributes, only the attributes of the first selected layer are updated.

If you select multiple elements of different types, only operations that can be performed on both elements. For example, if you select both a light and a layer, the Action menu looks something like this:
With a light and a layer selected, the following operations would be:

- Settings (first selected, in this case, the light)
- Manipulate transforms (both elements)
- Visibility (both elements)
- Duplicate (both elements)
- Delete (both elements)

**Scene Graph: Selecting Elements Directly in the Scene**

In addition to selecting elements in the Scene Graph, you can select them directly in the scene.

1. Pull your Support hand thumbstick toward you to open the Scene Graph.
2. Aim your Tool hand directly at the object in the scene and squeeze the trigger when it is highlighted.
3. Squeeze and hold the Support hand grip button to select additional elements.

Note that as you select elements in the scene that your selection is reflected in the Scene Graph.
Note also that the Action menu updates dynamically whether you select elements from the Scene Graph or from the scene itself.

Scene Graph: Toggling Visibility of Elements in Your Scene

To toggle visibility of individual elements in your scene:

1. Pull your Support hand thumbstick toward you to open the Scene Graph.
2. Aim your Tool hand at the eye icon next to the node whose visibility you want to toggle and squeeze the trigger:

![Scene Graph: Toggling Visibility of Elements](image)

*Left, both layers visible; right, visibility turned off for the sphere.*

**Notes:**

- You can hide Medium elements (such as the Mirror plane) without turning off their effect. For example, this means you can sculpt with the Mirror option enabled and not have to see the plane if you don’t want to.
- If you make the active layer invisible, you can still sculpt into it. If you hear the sounds effects of the tool but don’t see anything happening to your sculpt, make sure that you are sculpting in the correct layer.

Scene Graph: Renaming Elements in Your Scene

To rename an element in your scene:

1. Pull your Support hand thumbstick toward you to open the Scene Graph.
2. Select the node you want to rename.
3. Select the Rename button in the lower right corner of the menu.
4. Enter the element’s new name on the keyboard:

![Keyboard Image]

**Scene Graph: Restructuring Elements in Your Scene**

You can use the Scene Graph to change the hierarchy of your scene using both “drag and drop” and multiple selection.

To restructure elements in your scene:

1. Pull your Support hand thumbstick toward you to open the Scene Graph.
2. Select the node(s) you want to move:

![Scene Graph Image]

3. Squeeze and hold the Tool hand trigger and drag the selected nodes over the target location in the scene hierarchy. As you drag the selected nodes, different target locations in the tree are highlighted in blue; when you hover over the target, it turns yellow, and if you release the node, it will be moved to that location.
4. Release the trigger when the correct target location is highlighted:

Notes:

- To change the order of the element, select the shorter blue bar under the target node (to the left).
- To reparent the node being dragged, select the longer blue bar under the target node (to the right).
5. You can place multiple elements under a single parent (below left) or nest them into a hierarchy as needed (below right):

**Note:** The World node is the root level; you cannot restructure it under another node.
The Add Menu

Adding Layers

As yoursculpts get more complex, you may need to create different layers to hold different parts of yoursculpt. For more information on adding layers, and layers in general, see Working with Layers.

Adding Reference Meshes

You can import meshes from other 3D packages into Medium to use as references in your sculpting. A reference mesh appears as a transparent, triangulated model that can be used as a 3D guide when sculpting.

You can import reference meshes in either of the following file formats:

- .obj
- .fbx

Meshes from both formats can be brought into Medium with vertex color and texture information. Each format has slightly different requirements:

- **OBJ** - Medium uses a non-standard extension to the OBJ file format to support vertex colors inside the OBJ file. For textures, we require a .obj file, accompanying .mtl file, and all image files. We support one diffuse texture per subset. All files should be included in the Medium Import folder.
- **FBX** - Medium’s FBX importer supports one diffuse texture per mesh node inside the .fbx file. Each image file, as well as the .fbx file itself, should be included in the Medium import folder. Normal maps, multiple blended textures, and other special usage of textures are not supported and are not brought into Medium. If you are having issues with import, make sure that you have included all textures files with correct pathing in of the import folder, and make sure that each mesh node contains only one diffuse texture.

Recommendations for Reference Meshes

In general, we recommend that reference meshes you plan to import have vertex normals and bewatertight.

- Watertightness isn’t required for the reference mesh in general, it is strongly recommended for meshes with which you plan to use the Copy to Clay feature (see below). Non-watertight
meshes may fail to copy or show errors in the final sculpt. While minor errors in the geometry may not cause problems with Copy to Clay, it’s best for the mesh to be completely watertight.

- It is not necessary to triangulate meshes, as they are automatically triangulated upon import.
- Vertex normals are not strictly required either; however, reference meshes imported without normals show up unlit inside of Medium, giving them a uniformly flat gray appearance.

**Importing and Positioning a Reference Mesh**

To import a reference mesh:

1. Pull the Support hand thumbstick toward you to open the file selector and navigate to the directory containing the mesh:

2. Aim at the mesh you want to import with the Tool hand and squeeze the Tool hand trigger to select it:

3. Select the Add button in the lower right corner of the panel:
4. The reference mesh appears in both your scene and in the Scene Graph:

5. Squeeze the Support hand trigger to “grab” and position the mesh in your scene.
6. Select the reference mesh in the Scene Graph to see additional options on the Action menu:

**Wireframe**
Displays the mesh in wireframe mode.

**Copy to Clay**
Converts the mesh into the most active layer of clay (and takes on that layer’s resolution). With Medium’s Copy to Clay feature, you can also convert reference meshes into sculptable material, preserving color information from your original mesh.
Making the Mesh Move with Your Sculpt

In earlier versions of Medium, a “Move with Sculpt” option could be set for a reference mesh; to make the mesh move with your sculpt, you can now simply reparent it in the Scene Graph. Drag the mesh under the Sculpt node to have the reference mesh move in unison with your sculpt.

Deleting a Reference Mesh

To remove a reference mesh from your scene:

1. Pull the Support hand thumbstick toward you.
2. Select the reference mesh you want to delete, either in the Scene Graph or in the scene.
3. Select the Delete button on the Action menu.

Adding Reference Images

You can import images into Medium and place them within your scene to use as references in your sculpting. You can import reference images in any of the following file formats:

- .png
- .jpg
- .jpeg
- .jpe
- .tga
- .bmp
- .gif

To import a reference mesh:

1. Pull the Support hand thumbstick toward you to open the file selector and navigate to the directory containing the image:
2. Aim at the image you want to import with the Tool hand and squeeze the Tool hand trigger to select it:

3. Select the Add button in the lower right corner of the panel:

4. Selected reference images appear in both your scene and in the Scene Graph:
5. Squeeze the Support hand trigger to “grab” and position the image in your scene.
6. Select the reference image in the Scene Graph to see additional options on the Action menu.

Once you’ve loaded the image, you can move and resize it:

1. Pull your Support hand trigger toward you, then select the image with your Tool hand trigger, either from the Scene Graph or selecting it directly in the scene.
2. Move and rotate it using the controller.
3. Resize the selected image using the “pinch and zoom” motion.

Making Reference Images Move with Your Sculpt

In earlier versions of Medium, a “Move with Sculpt” option could be set for a reference image; to make the image move with your sculpt, you can now simply reparent it in the Scene Graph. Drag the image under the appropriate sculpt node to have the reference image(s) move in unison with your sculpt.

Deleting a Reference Image

To remove a reference image from your scene:
1. Pull the Support hand thumbstick toward you.
2. Select the reference image you want to delete, either in the Scene Graph or in the scene.
3. Select the Delete button on the Action menu.

Adding Lights

Medium uses three types of lights:

- **Ambient light (Sun)** - a default ambient light is included in your scene by default. The ambient light has no point of origin and is applied universally to the scene. You cannot add an ambient light, but you can modify the Sun’s characteristics by choosing the World node in the Scene Graph, then selecting the Settings icon from the Action menu.

- **Spot lights** - spot lights have a specific position and cast light in a specific direction. The angle of the cone associated with the light can be adjusted.

- **Point lights** - point lights have a specific position and cast light in all direction.

Notes:

- A maximum of 8 lights can be added to your scene.
- You can add any combination of spot lights and point lights.
- Only one light is able to cast shadows, and it must be a spot light. To select which spot light casts shadows, select it (either in the Scene Graph or directly in the scene) and enable shadows on the Action menu.

To add a new light to your scene:

1. Pull the Support hand thumbstick toward you.
2. Select the light icon.
3. Select the type of light you want to create.
4. Select whether this should be the shadow casting light.

The light appears in your scene, and is selected by default. Squeeze and hold the Tool hand grip button to position and aim the light.

Adding Transforms

A transform is a node within the hierarchy of your scene that is a parent to all the elements underneath it. If you’re not familiar with them, it may be easiest to think of the transform as a ‘handle’ of sorts; that
handle is attached to all its child elements. You can select that transform and move, scale, or rotate it; when you do, all elements under that transform are affected by the operation and are moved, scaled, and/or rotated as a group. If you're using Medium as part of a production pipeline, you may have specific requirements about where transforms are included in your model.

To add a transform to your scene:

1. Pull the Support hand thumbstick toward you.
2. Select the transform icon.

The transform appears as the last element in your Scene Graph, and is selected by default.

Squeeze and hold the Tool hand grip button to manipulate the transform directly in the scene.

Move the transform anywhere in the hierarchy; for example, you may want to group related objects under the transform so they can be manipulated in unison:
You can then select the transform node in the scene graph and manipulate it just as you would any other element:

For more on using transforms, see Transforming Elements in Medium.
The Action Menu

As soon as you select at least one element in the Scene Graph, the Action menu opens. For example, if you select a single layer in the Scene Graph, you’ll see the following options on the Action menu:

Across the top of the Action menu are common actions that can be performed on many element types in Medium. These icons are:

- Settings
- Manipulate (Transforms)
- Visibility
- Duplicate
- Delete

Below the icons are element specific actions that can be performed on whatever is currently selected (either via the Scene Graph or directly in the scene).

With a single layer selected, you can:

- Flip it
- Create a stamp from it
- Center it within its bounding box
- Increase its resolution
- Decrease its resolution

Notice that some of the layer operations are not available. If you select two layers in the Scene Graph, you’ll see a number of additional actions that can be performed using two layers. In addition to the operations listed above, you can:

- Merge the two layers
- Create a shape based on their intersection
- Subtract the volume of one layer from another.

This behavior is consistent whenever you select multiple elements in the Scene Graph; the Action menu dynamically updates to show only those actions which can be performed on the set of elements. If you select two different types of
elements (say, the lathe and a light) then fewer available actions appear on the menu.

In this case, the only operation that is appropriate for the collected elements is to enable them. Using that control enables/disables all the selected elements.

**Settings**

Select the gear icon to open the Settings menu for the selected element(s).

- If you have only one element selected in the Scene Graph, the appropriate menu opens.
- If you have more than one element selected, the menu for the element you chose first opens.

Depending on the type of elements you have selected in the Scene Graph, one of the following menu types opens:

<table>
<thead>
<tr>
<th>Element Type</th>
<th>Menu</th>
<th>Affects</th>
</tr>
</thead>
<tbody>
<tr>
<td>World node</td>
<td>Scene Settings</td>
<td>Overall scene appearance.</td>
</tr>
<tr>
<td>Sculpt</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Layer</td>
<td>Materials</td>
<td>Surface attributes for the first selected layer.</td>
</tr>
<tr>
<td>Light</td>
<td>Light Attributes</td>
<td>Attributes for the selected light.</td>
</tr>
<tr>
<td>Export Transform</td>
<td>Transform</td>
<td>Used as the origin when exporting the sculpt as either .obj or .fbx.</td>
</tr>
<tr>
<td>Lathe</td>
<td>Lathe Settings</td>
<td>Position and orientation of the Lathe.</td>
</tr>
<tr>
<td>Mirror Plane</td>
<td>Mirror Settings</td>
<td>Position and orientation of the Mirror plane.</td>
</tr>
<tr>
<td>Desktop Audio</td>
<td>Desktop Audio Settings</td>
<td>Enable/disable the desktop audio connection.</td>
</tr>
</tbody>
</table>
Transform Selected

Select the hand icon to open the Transform menu. Transforms are applied to all selected elements, so you can use this, for example, to scale or rotate some layers of your sculpt without affecting others.

Show/Hide Selected

Select the visibility icon to toggle the visibility of the selected elements (either nodes on the Scene Graph or selected directly in the scene).

Duplicate Selected

Select the duplicate icon to make a copy of the element(s) you’ve selected on the Scene Graph. The copy appears with a numerically incremented name in the Scene Graph.

Delete Selected

Select the trash can icon to delete the element(s) you’ve selected on the Scene Graph.

Left, light selected; middle, choosing Duplicate on Action menu; right, duplicated light (transformed).
The Scene Settings Menu: Customizing Your Workspace

Use the Scene Settings menu to customize your working environment.

To open the Scene Settings menu:

1. Pull the Support hand thumbstick toward you.
2. Select the World node in the Scene Graph.
3. Select the Settings icon with your Tool hand.

As you make changes, they are reflected in your environment. For example, try turning the Skybox or Ground plane on and off, or change the brightness of the sun (which defines the brightness of the ambient light in your scene).

Sun Brightness

Sets the brightness of the sunlight (ambient light in the scene).
Sun Color

Sets the color of the sunlight (ambient light in the scene).

Background Color

Set the background color for the scene (visible only if the Skybox is turned off).

Skybox

The three-dimensional cloud-covered hemisphere that surrounds your workspace. If you prefer to work with a solid background color, turn this option off.

Ground Plane

The two-dimensional grid that appears in your workspace. The global origin is located where the two thick black lines meet (with +Z pointing up).

Bloom

The weak “glow” effect of sunlight that surrounds any objects (even menus). This effect simulates the similar real-world effect seen when viewing objects through a camera.

Set as Default

Make the currently selected scene settings your default settings.

- Any new scenes you create will use these defaults.
- These settings are persistent between sessions.

Reset to Default

Restores your last saved scene settings.

- If you have previously used the Set as default option above, those options are restored.
- If you have never saved your own defaults, factory settings are restored.
Working with Layers

When you’re working on a sculpt, you may want to work on one feature (such as your creature’s teeth) without affecting another feature (such as the creature’s jaw). In Medium, you can define “Layers” to contain discrete areas of your sculpt and work on them independently of one another.

Notes:

- In general, you can add any number of layers to your sculpt, within the memory limitations of your computer.
- In general, the current tool affects only the active layer. Some tools, however, are intended to affect more than one layer (such as Move). In those cases, you can use the settings menu for the tool to specify whether all layers or just the active layer are affected.

Viewing Layers for the Current Sculpt

You can open the Scene Graph to see the layers in the current sculpt:

1. Pull the Support hand thumbstick toward you to open the Scene Graph. Layers have a layer icon on their node, and the active layer is highlighted in green.

Adding Layers

To understand how layers work, start by adding some clay to your current scene with the Clay tool, or loading a sculpt from your library.

Next, add a new layer:

1. Pull the Support hand thumbstick toward you.
2. Select the Layer icon from the Add menu.
3. The new layer appears in the Scene Graph, and is automatically designated the active layer (highlighted in green). New layers are added as Layer 2, Layer 3, and so on.
4. Pull the Support hand thumbstick toward you again to hide the Scene Graph.

5. Use the Clay tool to add some more detail to your scene. The clay you add on one layer doesn’t blend with clay on other layers, even if it intersects:

In the image above, note the hard intersection between the top horn and the head. (If you later merge these two layers, Medium tries to preserve that hard edge.)

6. Select the Smooth tool and aim at your sculpt. Note that only the clay in the active layer is affected by the tool. (Again, check the settings menu for the selected tool to see whether it affects a single layer or all layers by default.)

Designating the Active Layer

As you add layers, you will invariably want to switch between one layer and another. There are two ways to select the layer you want to work on.

Selecting the Active Layer from the Scene Graph

To select the active layer from the Scene Graph:

1. Pull the Support hand thumbstick toward you.
2. Open the Scene Graph.
3. Aim the Tool hand at the layer you want to work on and squeeze the Tool hand trigger.

Selecting a layer makes it the active layer. Changes you make (such as adding or removing clay) are now made in that layer.
**Selecting the Active Layer Interactively**

You can also make a layer the active layer by pointing at it in your scene. This might be handy if you’ve created several layers but haven’t given them descriptive names yet:

1. Pull the Support hand thumbstick toward you.
2. Aim your Tool hand at your sculpt. As you aim at different parts of your sculpt, the content of each layer is highlighted.
3. Squeeze the Tool hand trigger to make the currently highlighted layer the active layer.

**Hiding and Showing Layers**

Once you have more than one layer in your scene, you may want to hide some layers while you’re working on others. To hide one or more layers:

1. Pull the Support hand thumbstick toward you.
2. Open the Scene Graph.
3. Aim the Tool hand at the “eye” icon next to the layer and squeeze the Tool hand trigger.

When the eye icon is crossed out, the layer is hidden; toggle the icon on or off to hide or show the selected layer.

You can also multi-select several layers and choose the visibility icon on the Action menu to hide/show all of the selected layers with one action.

**Duplicating Layers**

You can make an exact duplicate of an existing layer; the duplicate will have the same name as the original but will have a higher numeric extension (e.g., the duplicate of Layer 1 will be Layer 2 or Layer 3). You might want to make a duplicate to try out some specific techniques and compare the two versions, or to make a copy of an element you want to flip across the mirror axis when sculpting a symmetrical model.

To make an exact duplicate of a layer:

1. Pull the Support hand thumbstick toward you.
2. Open the Scene Graph.
3. Select the layer you want to duplicate.
4. Select the Duplicate icon on the Action menu.
Deleting Layers

If you change your mind about changes you’ve made to a layer and want to completely remove it:

1. Pull the Support hand thumbstick toward you.
2. Open the Scene Graph.
3. Select the layer you want to delete.
4. Select the Trash icon on the Action menu.

Renaming Layers

As you add layers, you may need to clarify what each layer in the scene represents. To give a layer a new name:

1. Pull the Support hand thumbstick toward you.
2. Open the Scene Graph.
3. Select the layer you want to rename.
4. Select the Rename button in the lower right corner of the Scene Graph.
5. Enter a new name on the keyboard:

Merging Layers

If you’ve worked in more than one layer and want to combine them:

1. Pull the Support hand thumbstick toward you.
2. Open the Scene Graph.
3. Select the layers you want to combine.
4. Select Combine from the Actions menu.

Notes:

- If the merged layers have different resolutions, they are combined at the highest resolution (to avoid any loss of detail).
• If the layers have different materials, the merged layer uses the material of the highest layer on the layers list (for example, if Layer 1 were ‘red’ and Layer 2 were ‘blue’, the merged layer would be ‘red’).

**Subtracting Layers**

If you’ve worked in more than one layer, and there’s some overlap between the two, you may want to throw away the geometry that overlaps. To subtract one or more layers from another layer:

1. Pull the Support hand thumbstick toward you.
2. Open the Scene Graph.
3. Select the layer you want to keep.
4. Select the layer(s) you want to subtract.
5. Select Subtract from the Actions menu.

*Left, cube and sphere; right, after selecting cube first, then sphere, then choosing Subtract.*

**Finding the Intersection Between Layers**

In some cases, you may want to create a new shape from the intersection of two existing layers. To create a shape that contains only the overlap between the selected layers:

1. Pull the Support hand thumbstick toward you.
2. Open the Scene Graph.
3. Select the overlapping layer(s).
4. Select Intersect from the Actions menu.
Flipping a Layer Across the Mirror Plane

You may find that you want to “mirror” the content of a layer you’ve created across the mirror plane. Flipping a layer moves the clay across the mirror plane as if it were a reflection of the original. (You can Duplicate a layer and then Flip the copy across the mirror plane if you want to reproduce the same shape on both sides of your sculpt.)

To flip a layer:

1. Pull the Support hand thumbstick toward you.
2. Open the Scene Graph.
3. Select the layer(s) you want to flip.
4. Select Flip from the Actions menu.
Centering the Content of a Layer

Centers the contents of the layer within the bounding box. This feature is useful if you are butting up against one side of the bounding box and need a little more elbow room.

Increasing the Resolution of a Layer

While sculpting, you may find that certain fine details start to “break up.” To enable sculpting with a higher level of detail in a selected layer, you can increase its resolution. To increase the resolution for a layer:

1. Pull the Support hand thumbstick toward you.
2. Open the Scene Graph.
3. Select the layer whose resolution you want to increase.
4. Select Increase Res from the Actions menu.

In general, you won’t see much of a visual effect immediately after using Increase Resolution on a layer; however, after using the command you should be able to sculpt with a finer level of detail. For more information, see When to Increase Your Sculpt’s Resolution.

If you hover over the Increase Res command on the Action menu, you’ll see a preview of the resolution change, represented by a regular arrangement of 3D boxes around the volume of your sculpt:

As you increase or decrease the resolution, the size of the boxes change to give you a better idea of the level of detail you can work at.
Notes:

- Resolution can be different for each layer.
- Increasing resolution uses additional RAM in your machine. If increasing the resolution for a detailed sculpt would exceed the available RAM, Medium gives you a warning.
- Increase resolution only for the layers where you need the additional detail; increasing the resolution for a relatively smooth layer can use up your computer’s RAM unnecessarily.

Decreasing the Resolution of a Layer

Decreasing resolution intelligently discards unnecessary information for the selected layers (e.g., along regular surfaces) while trying to maintain the sculpt’s form. While you may have to initially increase the resolution of a layer in order to sculpt the fine detail you want, you may also find that you can later decrease the layer’s resolution after you’ve done so in order to reduce the memory footprint of your sculpt. To decrease the resolution for a layer:

1. Pull the Support hand thumbstick toward you.
2. Open the Scene Graph.
3. Select the layer whose resolution you want to decrease.
4. Select Decrease Res from the Actions menu.

Review your sculpt after decreasing its resolution; after using the command you may see that certain areas have lost too much detail, and you can Undo the action. For more information, see When to Decrease Your Sculpt’s Resolution.

Notes on Layer Resolution

- Resolution can be different for each layer.
- If decreasing resolution removes too much detail, use Undo to restore the higher resolution version.
- If you’re working within a production pipeline, you might also choose to keep your original at a higher resolution, and then change the number of triangles when exporting your sculpt.
Understanding Your Sculpt’s Resolution

When you sculpt, each layer has a given resolution. The layer’s resolution determines the level of detail you can add to that layer; the higher the resolution, the more detail supported. If one part of your sculpt does not require fine detail, you can sculpt at a lower resolution, and increase resolution only for those layers where you need more detail.

If you’ve worked in a 2D image editing program, it may help to think in terms of increasing resolution for an image. Images with higher resolution have more pixels per unit of measurement than images with lower resolution. Increasing the resolution of a layer enables you to sculpt with greater level of detail.

**Note:** Increasing the resolution of a layer requires more RAM on your PC. Medium notifies you if increasing the resolution of a layer would require more memory than you have.

**When to Increase Your Sculpt’s Resolution**

You may find that your sculpt starts to break apart when you’re trying to add detail, particularly when you use tools such as Move or Swirl, which can increase the resolution for the layer. Consider what might happen if you were to rotate the end of a tendril on a dragon’s face:

If you were to zoom in, you might see debris from where the surface broke up:
Sculpting fine detail at default resolution

To prevent this from happening, you can increase the resolution for the layer you’re working on:

1. Pull the thumbstick on your Support hand toward you.
2. On the Scene Graph, select the layer which includes the part of the sculpt you are working on.
3. On the Action menu, select Increase Res.

After a brief pause (while the layer’s resolution is increased), you can begin sculpting again. Doing the same gesture can now be supported and results in a continuous surface:

Sculpting detail after increasing the layer’s resolution
When to Decrease Your Sculpt’s Resolution

While *increasing* a layer’s resolution happens for artistic reasons, *decreasing* its resolution is usually done only when your computer is running low on memory. As mentioned above, each time you increase the resolution for your sculpt, it uses more of your machine’s available RAM.

If you run into the situation where Medium warns you that it is running out of memory, you can try decreasing the resolution for a layer, evaluating whether the loss in resolution affects its surface fidelity. In many cases, reducing the resolution one time may be acceptable:

![Dragon head, high resolution](image1)
![Dragon head, low resolution](image2)

In the sample images above, note the loss of some fine detail and surface texture. Depending on the surface characteristics of your model, decreasing a layer’s resolution may be an acceptable option when you run into memory limits.

**Note:** The decrease resolution operation can be undone if the reduction removes too much detail.
The Bounding Box

As you move your sculpt around, you may notice the thin outlines of a “bounding box” around it:

The bounding box defines the area in which you can sculpt; think of it as your 3D canvas. If your stroke runs into one of the sides of the bounding box, it will stop and you’ll see something like this:

- The bounding box helps you *visualize* your sculpt's *resolution*. Keep the size of the bounding box in mind when you start your sculpt, to make sure you don’t start at too large a scale.
Working with Stamps

Stamps are previously saved sculpts that can be used as the shape through which you add clay to your current sculpt. In Medium, you can:

- Choose from Medium’s default library of stamps.
- Create, save, and re-use your own stamps.
- Organize your stamps into meaningful collections.

While the Clay tool defaults to a sphere shape, building up a stamp library of the shapes you use most can make your work more productive. Sculpting with stamps is useful for:

- Repetitive detail (bolts along a metal seam).
- Surface textures (bumps or warts on skin).
- Repeating forms at different scales (rocks in an environment).
Selecting a Stamp

You can select a stamp to use from the Clay Settings menu.

1. With the Clay tool selected, tap on the Gear button on your Tool hand. The three shapes at the top of the Clay settings menu (the sphere, cube and capsule) are stamps as well; when you first select the Clay tool, the default sphere is a stamp.

2. Select Stamps to see the collections of available stamps.

3. The Clay settings menu expands, revealing Medium’s default collections of stamps.

4. Select a collection to see the stamps it contains (or select [All] to preview all available stamps). Stamps you created previously appear in the [Custom] collection.

5. If needed, scroll up and down through the list by dragging the handle on the elevator bar on the right of the menu, or select the left facing arrow on the left side of the menu to return to the collection list.

6. Point at the stamp you want to use and squeeze the Tool hand trigger to select it.
After you select the stamp, the tool preview changes to the shape of that stamp:

Once you’ve selected a stamp, you can add or remove clay using that shape. For example, you might use stamps to:

- Add repetitive detail on the surface of an object (such as rivets on the surface of a tank, or boulders in an environment).
- Make the Clay tool behave more like traditional modeling tools used for cutting, scraping, shaping and smoothing your sculpt.

Changing the Orientation of the Current Stamp

If the orientation of the stamp is awkward for the sculpt you’re doing, you can reposition it with respect to the Clay tool:

1. Select the stamp you want to use.
2. Move and hold the Tool hand thumbstick to the right. A banner appears in your scene:
3. The preview object temporarily ‘detaches’ from the tool; reposition the tool so its orientation to
the stamp preview is more comfortable.

4. Release the Tool hand trigger to set the new orientation.

Creating Your Own Stamps

You can create your own stamp based on the contents of a single layer. In preparation, you might add a
layer, then sculpt a shape that you would want to use across multiple sessions. You can use stamps, for
example, to create teeth, rivets, nuts and bolts, surface textures, and so forth...things that you might use
over and over in different sculpts. To create a stamp from a layer:

1. Sculpt the shape you want to make into a stamp; make sure it’s on its own layer:

2. Pull the Support hand thumbstick toward you.

3. Open the Scene Graph.

4. Select the layer that contains the clay you want to convert to a stamp.
5. On the Action menu, select Stamp.

6. The layer is automatically converted to a stamp and added as the current shape for the Clay tool.

You can immediately begin sculpting using the stamp:
The stamp is also automatically added to the Custom stamp collection, using the name of the layer. Stamps you create on your own are no different from those that come with Medium:

Where Stamps are Saved

The actual files for stamps are saved in the following directory:

```
C:\Users\Rift\Documents\Medium\Stamps\<username>\Custom\<timestamp>\layer-name
```

Once saved, you can re-use the stamp in any session. Stamps are stored as a high-resolution versions of the selected layer. (This ensures that the shape retains its fidelity the next time you load the stamp.) The stamp remains in that location even if you change the collection to which it belongs.

Note also that when a stamp is made from importing a mesh, the new stamp is saved in the following directory:

```
C:\Users\Rift\Documents\Medium\Stamps\<username>\Custom\<name-of-mesh>
```

Color Information with Stamps

Unlike in earlier versions of Medium, clay color is now saved with each stamp. This means that when you are creating a stamp, you’ll need to think about how you’re going to use it.
If you want to use the stamp to create duplicates of a colored object, then sculpt with colored clay or paint your layers before saving. You might use this option, for example, if you created a detailed palm tree that you wanted to place over and over along a beach.

When you save a colored stamp, using that stamp in the future will use the saved colors regardless of the currently selected clay color.

If you want to be able to use different color clays when sculpting with your stamp, such as a shape you might use as a sculpting tool, then use white clay when creating the stamp.

When viewing your stamps in either stamp browser or asset browser, none of the mesh previews of colored stamps that are made with vertex colors will have color. Colored stamps with texture will have colored mesh previews.

Organizing Your Stamps

Your stamp collections contain any stamps that you have previously saved (as well as the default collection of stamps that came with Medium). Stamps are organized into collections; when you press the Settings button with the Clay tool selected, you can select [Stamps] to see the most recently used stamps, the available collections, or import .fbx or .obj files as stamps:
Importing a Mesh as a Stamp

You can import meshes that you’ve created in other applications and use them as stamps in Medium. Shapes for import must be in either .fbx or .obj format.

To import a stamp (or stamps):

1. Select the Clay tool.
2. Press the Settings button on the Tool hand.
3. Select [Stamps].
4. Select [Import Stamps] below the list of stamp collections on the Clay settings menu:

5. Using the file selector, navigate to the directory containing the mesh you want to load as a stamp, then select it with the Tool hand:
6. After selecting the stamp, select [Import] at the lower right of the dialog:

The stamp appears is added to your Custom collection, and can be moved from there into any other collection (as described below).

Moving a Stamp to a New or Different Collection

When you save a stamp, it’s saved by default to the Custom collection. However, you may want to move the stamps you’ve created into other collections. To move a stamp:

1. Select the Clay tool.
2. Press the Settings button on the Tool hand.
3. Select [Stamps].
4. Select the edit icon to the right of the collection that contains the stamp:
5. A dialog opens, showing the stamps in the collection. With the Tool hand, select the stamp you want to move to a new collection:

6. Choose [Change Collection] from the stamp dialog:

7. Use the keyboard to enter the name of the destination collection:
   - If you enter the name of an existing collection, the stamp is moved there.
   - If you enter a new collection name, the collection is create and the stamp is moved into it.

   **Note:** If you move the last stamp out of a collection, that collection is automatically removed from your library.
Renaming a Stamp

To rename a stamp:

1. Select the Clay tool.
2. Press the Settings button on the Tool hand.
3. Select [Stamps].
4. Select the edit icon to the right of the collection that contains the stamp.
5. Select the stamp with your Tool hand.
6. Select the ellipsis ("...") next to the name of your stamp:

   ![Ellipsis Example]

7. Enter a new name on the keyboard:

   ![Keyboard Example]

Deleting a Stamp

To delete a stamp:

1. Select the Clay tool.
2. Press the Settings button on the Tool hand.
3. Select [Stamps].
4. Select the edit icon to the right of the collection that contains the stamp.
5. Select the stamp with your Tool hand.
6. Select [Delete Stamp]:

   ![Delete Stamp Example]
7. When prompted, confirm that you want to delete the stamp, or cancel if you change your mind:

Note: If you delete the last stamp from a collection, that collection is automatically removed from your library.
Using the Color Menu

You can use Medium’s Color menu to select colors for elements such as the clay, paint, lights and so forth in your scene.

For example, to set the color of the clay you add with the Clay tool:

1. Select the Clay tool.
2. Tap the Color button on the Tool hand.
3. To choose a color, do one of the following:
   a. Aim the Tool hand at the color you want to use in the colorspace and squeeze the trigger to select.
   b. Adjust the saturation and value sliders.
   c. Adjust the RGB sliders:

![Color Menu Diagram]

-117-
4. **Add some clay to your sculpt:**

You can select different clay colors for different parts of your sculpt.

**Note:** You can tweak additional material attributes for your sculpt (for example, bumping its specular component) to give better lighting information about the surface.

**Parts of the Color Menu**

There are four parts to the Color menu:

**Eyedropper**

Use the eyedropper to select a color from the surface of your sculpt:

1. Select the eyedropper with your Tool hand.
2. Aim the eyedropper at your sculpt and squeeze the Tool hand trigger to select a color from the sculpt’s surface.

**Color Picker**

Aim at the color space and squeeze the Tool hand trigger to select your current color.

**Color Bar**

Aim at the triangle to the right of the color bar.

Squeeze the Tool hand trigger to drag the triangle up and down to select a new tone.
Color Sliders

**Saturation**

- Drag the handle to the *left* to go to white.
- Drag the handle to the *right* to go to full saturation for the selected color.

**Value**

- Drag the handle to the *left* to go to black.
- Drag the handle to the *right* to go to full value for the selected color.

**Red, Green and Blue**

- Drag the handles left and right to adjust the individual components of the color.
Lighting Your Workspace

Medium lets you set up both ambient and directional lighting for your workspace. You can also modify surface material of your sculpt, including the material type and attributes like Diffuse Light to define how your sculpt is affected by lights in the scene.

When you first start sculpting, Medium uses a default spot light and a default ambient light to illuminate your work. You can add more lights to your scene (both spot lights and point lights), or convert them from one type to another.

Setting Up the Default Ambient Lighting for Your Scene

The characteristics of the default ambient light (the “Sun”) in your scene is determined by the Sun brightness and Sun color. To set the brightness and color of the ambient light in your scene:

1. Pull the Support hand thumbstick toward you.
2. Select the World node on the Scene Graph.
3. Select Settings on the Action menu.
4. Adjust the Sun brightness value (default value is 1.0) by dragging the slider left or right.
5. Select the Sun color using the Color menu.

Positioning Lights in Your Scene

When you start sculpting in Medium, your sculpt is lit with a single default spotlight which you can position wherever you like in your scene. Changing the position of the spotlight can dramatically affect the visual characteristics of your sculpt:

To change a light’s position:
1. Pull the Support hand thumbstick toward you (this will open the Scene Graph).
2. Look up until you see the light object.
3. Select the light object with your Tool hand.
4. Squeeze the Grip button on your support hand and move the light object.
5. Release the Grip button when the light object is in the position you want.

You can also use the Transform menu to position a light.

**Note:** If you want a light (or set of lights) to move in unison with your sculpt, you should restructure them under your sculpt object in the Scene Graph. See Scene Graph: Restructuring Elements in Your Scene.

### Changing a Light’s Attributes

To modify the characteristics of a light:

1. Pull the thumbstick on the Support hand toward you (this will open the Scene Graph).
2. Look up until you see the light object.
3. Select the light object with your Tool hand.
4. Select the Settings icon on the Action menu.

Depending on whether you are manipulating a spotlight or a point light, you’ll see one of the following menus:
Left, settings for Spot lights, right, for Point lights

**Brightness**

Set the relative brightness of the light.

**Color**

Select this field with the Tool hand to open the Color menu and select a color for the light.

**Type**

Choose the light type. Medium supports two light types:

- Spot
- Point

You can also use this option to change an existing light from one type to the other and back, depending on the lighting effect you want:
Left, series of three spotlights; right, same lights converted to point lights

**Cone Width (spotlights only)**

Adjust the angle of the spotlight; higher values give the spotlight a larger spot angle.

**Radius (point lights only)**

Adjust the radius of the point light; higher values give the point light a larger radius of effect.
Defining Materials for Your Sculpt

Materials define the inherent surface attributes for your sculpt. They determine, for example, how rough or shiny your sculpt looks, how prominent the shadows appear, and how lights in the scene interact with it. Material attributes can be set individually for each layer in your sculpt.

Defining Materials for a Layer

To select material attributes for a layer:

1. Pull the Support hand thumbstick toward you.
2. Select the layer you want to work with (aim at either the layer’s name in the Scene Graph or directly at the layer in your scene, and squeeze your Tool hand trigger).
3. Select the Settings button on the Action menu.

Across the top of the menu, you’ll see the three basic material categories:

- **Default** - basic attributes that would be used to describe a “clay” or “plastic” surface.
- **Metal** - assign attributes that give the surface a more metallic appearance.
- **Emissive** - assign attributes that give the surface a glowing appearance.

Default Material Attributes

**Diffuse Light**

Sets how strongly the lighting in the scene affects the layer’s surface. Setting the value all the way to zero negates any impact diffuse light might have on the clay’s color, so the “base” paint color is shown at 100%.
Diffuse light: Left, 1.0, right, 0.0.

Diffuse Color

Changes how strongly the diffuse color of the layer is rendered. You can use this option, for example, to set the Diffuse Color to zero, to temporarily “hide” any surface color detail (paint) and shows the underlying sculpt.

Diffuse color: Left = 0.0, right = 1.0

Specular

Changes how intensely directional lights (including the Medium spotlight) reflect off the surface of the layer. A higher value creates a more visible specular effect, and generally gives a more “metallic” or “shiny” appearance (depending on other attributes).
Specular: Left = 1.0, right = 0.0.

**Roughness**

Changes the overall surface quality of the layer. Lower values give a shinier appearance to the layer, while higher values give it a more matte finish. This attribute goes hand-in-hand with the Specular setting, and is more apparent if you have at least some specular component in your surface attributes or when using the metal material.

Roughness: Left = 1.0, right = 0.0.

**Occlusion**

Changes the relative darkness of the areas of your sculpt with surface direction change (crevices, bumps, creases, etc.). Higher values make occluded surface areas darker. Note that if your surface area is regular (such as a sphere) this attribute’s effect is not visible.
Occlusion: Left, low occlusion, right, high occlusion.

Metal Material Attributes

Selecting the Metal material gives the layer a baseline metallic appearance. The Metal material is great for metal details (think armor, swords, or nuts and bolts).

**Metal Roughness**

Set the sculpt’s surface appearance to vary from very smooth (think “chrome”) to very rough (think “oxidized iron”).

Metal Roughness: Left, low metal roughness, right, high metal roughness.

**Diffuse Light**

See Diffuse Light above.
Occlusion

See Occlusion above.

Emissive Material Attributes

The Emissive material gives the layer a glowing appearance. It’s useful for creating elements such as light bulbs, neon signs, and the like.

Emissive Strength

Sets how strongly the layer appears to glow. Objects using the Emissive material will appear completely black when emissive strength is turned down, while high values create a glow:

Emissive Strength: Left, low emissive strength, right, high emissive strength.
Transforming Elements in Medium

Transforms are a way to mathematically describe the position, scale (size) and rotation of an element in your scene. When you transform your sculpt, for example, it doesn’t change the inherent shape or surface detail of the clay, but rather changes its relationship to the space around it.

There are two general categories of things that you can transform in Medium:

- **Layers of your Sculpt** - transform one or more layers of your sculpt.
- **Scene Elements** - reposition lights, the lathe and other scene elements to customize your workspace.

**Note:** Transforming a layer of your sculpt is not the same as using the Move tool. The Move tool actually pushes or pulls the clay (even if the whole layer is contained within the bounds of the Move tool preview); transforms are limited to position, scale, and rotation, and express the relationship of the object to its world space.

**Transforms: Frame of Reference**

Transforms also have a *frame of reference*; the frame of reference defines the space in which the transform is applied, and the transform is applied relative to a specific *origin*.

Medium supports the following frames of reference:

- **World space** - transforms are applied relative to the global origin (the point at which the dark lines drawn on the ground plane meet). You can think of this as an environmental frame of reference.
- **Sculpt space** - transforms are applied relative to the sculpt origin. The sculpt origin is the parent level for all layers in your sculpt.
- **Object space** - transforms are applied relative to the layer’s origin.

**Transforming Layers**

Transform operations let you move, scale, or rotate the selected layers using one of two methods:

- **Interactively** — select one or more layers, choose an operation, then manipulate the appropriate types of handles that appear around the element.
- Menus — select one or more elements in the Scene Graph, then enter values directly on the transform menu.

**Note:** A given layer can also be referred to as an *object*, and you will see that terminology on some of Medium’s transform menus.

**Transforming a Layer Freehand**

To transform a layer freehand:

1. Pull the Support hand thumbstick toward you so that the Scene Graph appears.
2. Select the layer you want to transform using either of the following methods (selected layers turn green when selected):
   - Aim the Tool hand at the layer on the menu and squeeze the Tool hand trigger.
   - Aim the Tool hand at the part of your sculpt that corresponds to the layer and squeeze the Tool hand trigger.
3. Squeeze the Grip button on either hand and move or rotate the object (by default, the object moves relative to the displayed sculpt origin, which remains stationary). Squeeze both grip buttons and move the controllers toward or away from each other to scale the layer:

**Transforming Multiple Layers Freehand**

If you've created a sculpt and want to transform several layers at once, select them *before* executing the transform operation:

1. Pull the Support hand thumbstick toward you so that the Scene Graph appears.
2. Select the layers you want to transform using either of the following methods:
   - Squeeze the Support hand trigger and select multiple layers from the scene with the Tool hand trigger (selected layers turn green when selected).
○ Squeeze the Support hand trigger and select multiple layers from the Scene Graph with the Tool hand trigger (selected layers are highlighted with a thin blue box).

3. Squeeze the Grip button on either hand and move or rotate the object (by default, the object moves relative to the displayed sculpt origin, which remains stationary). Squeeze both grip buttons and move the controllers toward or away from each other to scale the layers.

Selecting a Transform Operation for a Layer

To select a specific transform operation on an element:

1. Select the layer you want to transform using either of the following methods:
   ○ Aim the Tool hand at the layer on the menu and squeeze the Tool hand trigger.
   ○ Aim the Tool hand at the part of your sculpt that corresponds to the layer and squeeze the Tool hand trigger.

2. On the Action menu, select the transform button.

3. Select the transform operation you want to apply to the object:

Select from any of the following operations:

- Freehand transform (selected by default; see the previous section)
- Move
- Rotate
- Scale
- Set Pivot

Depending on which transform operation you select, a different menu appears (described in the following sections).
Move Layers Freehand

To move a layer along any of the X, Y, or Z axes:

1. Select the Move transform operation (the white sphere with six arrows pointing away from it).
   Two things happen:
   - Move manipulators appear around the selected objects (red, blue and green cones).
   - The Move Transform Settings menu opens.
2. Aim the Tool hand at any of the manipulators and drag it to a new location; the object moves relative to the origin for the specified coordinate space:

   Left, original object at sculpt origin, right, object translated along the Z axis by dragging the move manipulator.

Move Transform Settings Menu

When you select the move transform operation, the Move Transform Settings menu opens above the Action menu:
Move Axis

Shows the current values for the object’s X, Y and Z axes.

- Click on any number to enter a new value.
- Click on the “X” to zero out that transform.

Coordinate space

Selects the frame of reference for the transform. Moves are executed relative to the world, sculpt, or object origin.

Snap

If enabled, you can enter a snap increment. The object moves only in the specified increment.

Rotate Layers Freehand

To rotate a layer around any of the X, Y, or Z axes:

1. Select the Rotate transform operation (the white sphere with three rings around it). Two things happen:
   - Rotate manipulators appear around your object (red, blue and green rings).
   - The Rotate Transform Settings menu opens.
2. Aim the Tool hand at any of the rings and rotate it to a new orientation; the object rotates around the axes for the specified coordinate space:

Left, original object at sculpt origin, right, object rotated about the Y axis by dragging the rotate manipulator.
**Rotate Transform Settings Menu**

When you select the rotate transform operation, the Rotate Transform Settings menu opens:

![Rotate Transform Settings Menu](image)

*Rotation Axis*

Shows the current values for the object’s rotation around the X, Y and Z axes.

- Click on any number to enter a new value.
- Click on the “X” to zero out that transform.

*Coordinate space*

Selects the frame of reference for the transform. Rotations are executed relative to the world, sculpt, or object origin.

*Snap*

If enabled, you can enter a snap increment. The object rotates only in the specified increment.

**Scale Layers Freehand**

To scale a layer:

1. Select the Scale transform operation (the white sphere with three arrows pointing away from it, surrounded by a white dotted line). Two things happen:
   - Scale manipulators appear (six yellow rectangles).
   - The Scale Transform Settings menu opens.

2. Aim the Tool hand at any of the manipulators and drag it to a new location; the object moves relative to the origin for the specified coordinate space:
Left, original object at sculpt origin, right, object scaled up by dragging a scale manipulator.

**Note:** For the Scale operation, the resizing is uniform regardless of which handle you select.

**Scale Transform Settings Menu**

When you select the scale transform operation, the Scale Transform Settings menu opens:

**Move Axis**
Shows the current scaling factor.

**Coordinate space**
Selects the frame of reference for the transform. Scales are executed relative to the world, sculpt, or object origin.

**Snap**
If enabled, you can enter a snap increment. The object is scaled only in the specified increment.
Setting the Pivot Point (Object Origin) for a Layer

You can set the *pivot point* for a layer. You can think of the pivot point as the layer’s origin. To set the pivot point’s new position:

1. After selecting the move, rotate or scale operation, also select the Pivot Point icon (the red, green, and blue axes at the far right). A small set of red, green and blue axes appears at the object origin.
2. Use the manipulators to transform the position or orientation of the *object* (layer) origin.

After moving the pivot point (object/layer origin), transformations made in the object frame of reference will be based on this new location:

*Left, original object with object origin coincident to sculpt origin; right, object origin translated along the Z axis by dragging the move manipulator.*
Transforming Scene Elements

Just as you can transform layers on your sculpt, you can transform scene elements within Medium, including:

- Lights
- Reference Images
- Reference Meshes
- Lathe
- Mirror Plane
- Desktop Audio

Just as with layers, you can select multiple elements in the Scene Graph (e.g., a group of lights) and transform them as a set. To see the available transform operations for the selected elements, select the transform icon on the Action menu.

Reposition a Scene Element Freehand

For example, here’s how you could reposition a light freehand:

1. Pull the Support hand thumbstick toward you.
2. Aim your Tool hand at a light and squeeze the Tool hand trigger.

Reposition a Scene Element with the Transform Menu

For example, here’s how you could reposition the lathe using the Transform menu:

1. Pull the Support hand thumbstick toward you.
2. Select the Lathe node in the Scene Graph.
3. On the Action menu, choose the Transform icon to open the Transform menu.

**Translation Axes**

Click on the value next to either the X or Y to move the lathe to a new position along that axis.

**Coordinate Space**

Specify whether the move should be relative to the world origin or object origin.

**Snap**

If enabled, select an increment by which to translate the lathe when it is moved.
The Control Panel

The Control Panel includes options that you want to access frequently during a sculpting session. Use the Control Panel to:

- Load, save, import, and export your work.
- Set up capture of photos, video, or full VR sessions.
- Share your work in your Facebook feed or to your Oculus home page.
- Access the Medium feed to get the latest information about the application.
- Initiate a Studio Share session.
- Review notifications about Medium.
- Set user preferences.
- Exit Medium.

To open the Control Panel, press the yellow Control Panel button on the Support hand. Each of the options on the menu is described below.
New

Creates a new scene.

Note: Creating a new scene deletes your current scene. When you select this option, Medium asks you to confirm before proceeding.

Quick Save

If you loaded your sculpt from disk, Quick Save re-saves your work under the last specified filename, in the same directory. However, if this is the first time you’re saving, the Save Sculpt panel opens:
1. Using the file selector on the left, choose the directory where you want to save the sculpt.

2. Select the “Untitled” bar at the bottom of the panel and enter a name for the sculpt on the virtual keyboard that appears:

   - Use either hand to point at keys on the keyboard.
   - Squeeze the trigger on either hand to select (“press”) a key.

   Medium inserts the name “Untitled”, but you can modify the filename as you see fit:

   You can position the cursor by pointing and squeezing at a location inside the filename, or use any of the special keys on the keyboard:

   - **Arrow** - deletes a character.
   - **Clear** - clears the entire name.
   - **Enter** - saves your sculpt with the specified filename.
   - **+1** - increments the last digit in the filename. If the filename does not end in a number, a “1” is added (and can be incremented by repeating the gesture).

3. Select Save in the lower right corner of the Save Sculpt panel.
Once you’ve saved your work (or if you’re working on previous sculpt that you’ve loaded into Medium), the Quick Save option saves the sculpt with the previously specified filename in its original directory.

**Note:** The Quick Save option overwrites your previous work; earlier versions are not preserved. If you want to save a new version, use the Save As command.

**Save As...**

Saves your current scene, prompting for a filename before saving.

**Load...**

Loads a previously saved sculpt from your local file system. When you choose Load, the Load Sculpt panel opens:

1. Using the file selector on the left, choose the directory where the sculpt was previously saved.
2. Point your Tool hand at the sculpt you want to load and squeeze the Tool hand trigger. Additional information about the sculpt is displayed to the right of the preview panel.
3. Point your Tool hand at the [Load] button in the lower right corner of the panel and squeeze the Tool hand trigger to load the sculpt.

**Warning:** Loading a sculpt using the Load command will wipe out your current scene. Make sure you save your work before loading over your current scene. You cannot undo a scene load.
Add Mesh as Clay...

Loads an .fbx or .obj file from your local file system into Medium as clay. When you choose Add Mesh as Clay, the added mesh appears in addition to your existing sculpt. (You have the option when adding to specify that the imported mesh should appear as a new layer).

When you choose Add Mesh as Clay, the Add Mesh panel opens:

To load a mesh as clay:

1. Using the file selector on the left, choose the directory containing the mesh.
2. Point your Tool hand at the mesh you want to load and squeeze the Tool hand trigger. Additional information about the mesh is displayed to the right of the preview panel.
3. Point your Tool hand at the [Add] button in the lower right corner of the panel and squeeze the Tool hand trigger.
4. On the dialog that appears, tell Medium how you want to import the mesh.

**Layer Fill**
Manage the resolution at which the sculpt is imported.

**Split Mesh Into Separate Layers**
If the object you are importing consists of multiple objects, choose this option to load each as a separate layer.
Export...

Exports the current scene to your local file system in a non-Medium format (such as .obj or .fbx). In this section, you’ll learn:

● How to export your sculpt
● How the settings on the export menu affect your output
● What gets exported
● Where files are saved

After you’ve created your perfect sculpt, you may want to export it, either to move it along in your production pipeline, or perhaps for 3D printing.

To export your sculpt:

1. Tap the Control Panel button on your Support hand.
2. Select File > Export to open the Export menu.

You’ll use the Export menu to specify details about what to include with your export.

**Triangles**

Initially, this shows the number of triangles that the current sculpt would generate when exported as a mesh. You can optionally reduce the number of triangles to export:

● Select one of the presets (0.1, 1.0, 10.0 or 100.0) to perform a shortcut percentage decimation.
● Drag the handle on the slider left and right to select a specific number of triangles.

You can use either option (or a combination of both) to reach your target number of triangles for export.
Paint

You have two different ways to exported color information with your sculpt:

- **Vertex color** - a color value is assigned to each vertex on the exported mesh. No image files are generated when exporting a sculpt using vertex color.

- **Textures** - the mesh is “unfolded” onto a 2D image; the color information for each triangle on the sculpt is represented by a small piece of a texture map (image file). If you choose Textures, the menu expands to show additional options (see Exporting Texture Information below).

Mesh File Format

Select the mesh format option needed for your pipeline:

- .obj
- .fbx

What’s Exported and Where is it Saved?

By default, all files, include meshes and textures, are saved in the following folder of your Medium library:

C:\Users\Rift\Documents\Medium\Exports\<username>

However, you are free to navigate to a different location (including your favorites) using the file selector to save your exported content anywhere on your PC’s local filing system.
Exporting Texture Information

**Texture Size**

If you include textures as part of your export, you can optionally set the size of the exported image. Keep in mind that you’ll need to use a large enough image to support the number of triangles in your mesh. Using a texture map that is too small can cause a loss of texture detail in your export.

However, if your production pipeline dictates that a given object can only carry texture data of a certain size, you can use the presets (256, 512, 1024, 2048, 4096, and 8192) to export a map of those dimensions. For example, selecting 1024 exports a texture map 1024 pixels wide x 1024 pixels tall.

To export full texture data, deselect any of the presets.

**Normal Map Space**

Select the normal mapping option needed for your pipeline:

- Object
- Tangent

**Texture File Format**

Select the file format option needed for your pipeline:

- .tga
- .png

*Note:* PNG files save normal maps at a higher fidelity than TGA files. (PNG normal maps use 16 bits / channel, which avoids banding. Medium supports TGA normal maps for broad compatibility, but they use only 8 bits / channel.)
Capture

Use the Capture option in the Control Panel to record your work or play back previously recorded sessions. You can select from any of the following:

- Photo
- Video
- VR Record
- Playback

How to Take Photos of Your Work

You can take photos to share your progress with someone who’s reviewing your work, or to post for your friends on social media. You’ll need to select the point of view for the camera, and you’ll be able to preview what your picture will look like in a rectangular viewfinder.

Starting the Camera

To start your camera:
1. Tap the Control Panel button on your Support hand.
2. Select Capture > Photo.

The Capture menu opens next to your Support hand and stays there as long as you’re capturing. A viewfinder also opens, attached to your Support hand by default. (You can also attach the camera to your avatar’s head or position it at a specific place in the scene, as described below).

There are two ways to take a photo:

- Press the trigger on your Support hand to take a photo.

-or-

- Point your Tool hand at the camera icon at the bottom of the photo menu and squeeze the trigger.

**FOV**

Drag the handle on the Field of Vision slider to adjust the focal length of your camera’s lens. This is similar to zooming in and out with an adjustable camera lens.

**Note:** Extreme settings can add curvature to your photos (just like a real camera lens). A value of around 50 corresponds roughly to a ‘natural’ human view.

**Positioning the Camera**

Select one of the following POVs:

- **Hand** - attaches the camera to your Support hand. The viewfinder follows the position of your Support hand and you can preview the photo in the viewfinder.

- **Head** - attaches the camera to your head, and shows a preview of the photo in a small rectangle attached to the upper right corner of the photo menu. You take photos from your avatar’s point of view.

- **World** - positions the camera at a specific static location in your scene (a good option if you want to take photos of several consecutive steps from the same angle).
  - **Transform Manipulator** - to change the location of the camera in World mode, select the manipulator tool (next to the world icon). With this option selected, squeeze the Support hand trigger to move the viewfinder instead of your sculpt.
What’s Saved and Where?

Photos are saved as .png files in the following directory:

C:\Users\Rift\Documents\Medium\Photos\<username>

**Note:** Both a .png file and an .asset file are saved with each photo taken. The .asset file lets Medium keep track of which photos to display through the Library. If you delete a photo from this directory, make sure to delete the corresponding asset file.

How to Record a Video of Your Work

You can take videos to show how a specific sculpting technique, or to post for your friends on social media. You’ll need to select the point of view for the camera, and you’ll be able to preview what your picture will look like in a rectangular viewfinder.

Starting the Camera

To start your camera:

1. Tap the Control Panel button on your Support hand.
2. Select Capture > Video.

The Capture menu opens over your Support hand and stays there as long as you’re capturing.

A viewfinder also opens, attached to your Support hand by default. (You can also attach the camera to your avatar’s head or position it at a specific place in the scene, as described below).

To take a video:

1. Point your Tool hand at the start icon at the bottom of the Capture menu and squeeze to start recording.

**FOV (Field of View)**

Drag the handle on the Field of View slider to adjust the focal length of your camera’s lens. This is similar to zooming in and out with an adjustable camera lens.

**Note:** Extreme settings can add curvature to your photos (just like a real camera lens).
Positioning the Camera

Select one of the following points of view (POVs):

- **Hand** - attaches the camera to your Support hand. The viewfinder follows the position of your Support hand and you can preview the photo in the viewfinder.
- **Head** - attaches the camera to your head, and shows a preview of the photo in a small rectangle attached to the upper right corner of the photo menu. You take photos from your avatar’s point of view.
- **World** - positions the camera at a specific static location in your scene (a good option if you want to take photos of several consecutive steps from the same angle).
  - **Transform Manipulator** - to change the location of the camera in World mode, select the manipulator tool (next to the world icon). With this option selected, squeeze the Support hand grip button to reposition the viewfinder (instead of moving your sculpt).

Stop Recording and Exit

- To stop recording, select the stop icon at the bottom of the capture menu.
- To exit from capture mode, select the “X” on the upper left corner of the capture menu.

What’s Saved and Where?

Videos are saved as .mp4 files in the following folder:

C:\Users\rift\Documents\Medium\Videos\<user>

**Note:** Both an .mp4 file and an .asset file are saved with each photo taken, along with a preview image for the video. (The .asset file lets Medium keep track of what to display in the file selector.)

How to Record a VR Session of Your Work

You can record the entire contents of a VR session; unlike a photo or video, capturing a VR session also captures the actual work that is created (including any voice instructions you may include). You don’t need to worry about setting the camera position because during playback, the viewer will be able move into the best position independently, just as if he or she were looking over the artist’s shoulder.

**Note:** VR sessions use a lot of memory! Medium shows the amount of memory that has been devoted to the current VR session as you record.
Starting the Recording

To start your VR recording:

1. Tap the Control Panel button on your Support hand.
2. Select Capture > VR Record. The Capture menu opens over your Support hand and stays there as long as you’re capturing.
3. Point your Tool hand at the start icon (the red button) to start recording.
4. Start working

Stop Recording and Exit

- To stop recording, select the stop icon at the bottom of the capture menu.
- To exit from capture mode, select the “X” on the upper left corner of the capture menu.

What’s Saved and Where?

Videos are saved as .mp4 files in the following folder:

C:\Users\Rift\Documents\Medium\Recordings\<username>

Note: Both a recording (.rec) file and an .asset file are saved with each recording, along with a preview image for the recording. (The .asset file lets Medium keep track of what to display in the file selector.)

How to Playback a Video or VR Session

Videos and VR sessions are recordings made by Medium users that can be played back and watched by another user. You can load videos or VR sessions into your world and see them right alongside your current work and view them from any angle. To load a video or VR session:

1. Tap the Control Panel button on the Support hand.
2. Select Playback.
3. Select the VR Sessions or Video icon (depending on which you want to view).
4. Navigate to the directory containing the recording. A gallery view of all the videos or VR sessions in the selected folder opens.
5. Select a video or VR session by squeezing the trigger on your Tool hand. When you do, additional information appears to the right of the preview panel. From here, you can do any of the following:
   ○ Play - start the playback.
Delete - delete the item.

6. Select Play to start the playback.
   - If you are playing back a video, it appears in a panel that can be placed anywhere in your scene (select the manipulate icon at the far right of the playback menu).
   - If you are playing back a VR session, the user’s avatar appears in your workspace:

![VR session playback](image)

When playing back either a video or VR session, a set of playback controls appear on your Support hand. The playback controls do the following:

- Pause the session
- Stop
- Replay
- Change playback speed
- Manipulator (lets you reposition the VR content in your workspace)

To reposition the video playback screen or the VR tutorial content:

1. Select the manipulator icon (the rightmost playback menu).
2. Squeeze the grip button on the Support hand and reposition the content so you have a better view, then release the grip button.

**Note**: Both videos and VR sessions pause if you remove your headset, so you can take a break and then pick up where you left off.
Share

Use the Share option in the Control Panel to share your work to any of the following locations:

- Share to Web — shared your sculpt to the Oculus Medium website (https://www.oculus.com/medium)
- Share to Facebook — share your sculpt to your Facebook feed.
- Oculus Home — share your sculpt as an object you can place in your Oculus home.
Share Sculpt...

Use the Share Sculpt option in the Control Panel share your work to your gallery on the Medium website. When you select this option, the Share dialog opens. You’ll see a 3D preview of your object and its title at the top. When sharing sculpts to the Medium web site, you can edit the description and select a Creative Commons license completely in VR (as long as you’ve already signed in to your Oculus account):

**Description**

The description that will accompany the 3D sculpt.

**Sharing**

If selected, the sculpt will be visible to anyone who visits your gallery; if not selected, the exported sculpt is set to private.

**License**

Select the license under which you want to share your sculpt. A general description of the terms of the selected license appear in the text box under the license pulldown.

Choose the Share button when you’re ready to share your sculpt.

**Note:** You should read the entire Agreement (including the Read More) before sharing your work. That way you’ll know just what you’re sharing, with whom, and the terms of that sharing agreement.

If you navigate to the Oculus Medium site (https://www.oculus.com/medium) and visit your gallery, you’ll see your exported content as part of your gallery:
If you click on a sculpt in a public gallery (yours or anyone else’s), a 3D preview of the sculpt is displayed, (along with the option to import the sculpt into Medium or export it as a .obj file, shown below the preview):

If the file is your own, you can also use the Edit command to change information about the sculpt (including the license, name, etc.).

When sharing to the Medium website, keep the following in mind:

- Turning off your skybox in Medium renders your background with the solid color of your choosing; keeping the skybox on in Medium renders a gray gradient background.
- Only default material works are supported for sharing to Facebook (emissive or metal material will appear as default).
- The orientation of your sculpt can be found in your 2D preview image.
- There is currently an upload limit of 400 MB.

Share to Facebook

Share to Facebook generates a GLTF2 file and shares it to your Facebook feed as a 3D post. Your Medium sculpt is displayed as a 3D model that can be manipulated like a gyroscope and viewed in all its glory.
1. Log in to your Oculus account. If you aren’t logged into Facebook, you’ll get a dialog telling you that you should remove your headset and log in.

2. Before you can share to Facebook, you’ll need to log in to your Oculus account:

When prompted, continue to Facebook and give Oculus permission to send content to your Facebook feed:
Once you’ve given Oculus permission to send your sculpts to your Facebook feed, you’ll be able to select the Share to Facebook option. You’ll see a 3D preview of your object and an option to give it a brief description:

The dialog also lets you know which Facebook user’s account you are sharing to (and also gives you the opportunity to log out of Facebook).

Once exported, your sculpt appears directly in your Facebook feed:
Share Sculpt to Home...

The Share to Home option generates an object that you can place in your Oculus Home environment. In the Share to Home dialog, you’ll see a 3D preview of your object, along with its title (if you’ve previously named the sculpt. You can also click on the ellipsis (“...”) if you want to change the name before exporting:

![Share to Home dialog](image)

**Detail**

Depending on the type of object you’re sending to your Oculus Home, choose either Low or High level of detail. For common objects like a ball or a coffee mug choose Low, but for characters choose High. You can set the relative size for your sculpt by editing the Export Origin in the Scene Graph.

Inside Oculus Home, you’ll find your exported objects in the My Objects folder on the objects menu.

![Oculus Home interface](image)

You can select and place your models wherever you like in your Oculus home.
Feed

Your Medium Feed keeps you up to date with new material that you may find useful. Things you may find in your Feed include:

- Tutorials
- News Feed - Artist Spotlights, contest announcements, featured techniques, or free sculpts from guest artists.
- Medium team credits

Use the arrows at the bottom of the feed (or the elevator bar on the right) to scroll up and down through your Feed.

Tutorials

One of the best ways to get a good basic understanding of Medium is to load and follow the tutorials. The tutorials are a special set of videos that load and play right in your Medium workspace. (New tutorials of all levels are added frequently, so you may want to check in every once in awhile for new content.)

Video tutorials load right into your scene; they appear in a floating rectangle above the ground plane so you can watch them while (or before) you work.

To load and watch a video tutorial:

1. Press the Control Panel button on your Support hand.
2. Select Feed.
3. Scroll through the list of tutorials in the left column to find the one you want to watch, then aim at it with your Tool hand and squeeze the Tool hand trigger.

4. A larger screenshot of the tutorial appears, with some information about the author, a brief description of the tutorial, and when the tutorial was last changed. If this is the one you want to watch, select Play:

5. The video appears on a floating screen in your workspace, and a set of playback controls appears over your Support hand. The playback controls do the following:
   - Go to Previous Tutorial
   - Pause
   - Stop
   - Replay
   - Manipulator (lets you reposition the screen in your workspace)
   - Go to the Next Tutorial.

Loading a News Item

To load a News item, select the item from the “What’s New” column.
If the content includes a VR session, select the play button to start the playback.

If the content includes downloadable content, select Download. Your Support hand vibrates and a notification appears, telling you when the download has started and finished.

Credits

See who worked on Medium!
Studio Share

With Medium’s Studio Share, you can join another user in a shared workspace. In the Studio Share session, you can:

- Share advice and comments over the headset.
- See each other’s avatar.
- See each other’s current sculpt.

Inviting Another User to Studio Share

To initiate a Studio Share session:

1. Press the Control Panel button.
2. Select the Studio Share icon to see a list of your friends who are currently online with Oculus.
3. Select one of your friends to start a Studio Share session. After you select a friend, an invitation is sent:
If the friend accepts the invitation, you’ll see their avatar appear in Medium:
Accepting a Studio Share Invitation

If you are online with Oculus, and a friend sends you an invitation to Studio Share, you’ll first hear a tone on your headset.

- **Accept the invitation** - if you want to enter a Studio Share session.
- **Ignore the invitation** - if you’re busy and don’t want to Studio Share at the moment.

Once you accept the invitation, you can begin working together.

Working Together in a Studio Share Session

Once you have sent an invitation and your friend has accepted, you’ll see both avatars in your scene. You can talk to each other, move around each other’s sculpts, and work in a highly communal fashion.

**Note:** While you can sculpt simultaneously, you can’t sculpt on each other’s work.

Notifications

Opens the Notifications panel, where you can read important messages from the Medium team.
**User Preferences**

Opens the User Preferences menu. User Preferences are persistent across sessions and define some basic behaviors of Medium:

- **Double Press Speed**
  
  Some actions (such as opening the Settings menu) are enabled with the double tap of a button. This sets the maximum time in which two quick taps are recognized as a double tap gesture. If you’re double tapping on a button but not seeing the expected menu, you may want to increase this value:

  - Use a lower value if you’re quick on the draw.
  - Use a higher value if you work at a more relaxed pace.

- **First Time User**
  
  On startup, first time users are prompted to select their dominant hand and optionally load a tutorial. This behavior is automatically turned off after your first session.

- **Tooltips**
  
  Show tooltips when you hover over a menu option in Medium.

- **Application sounds**
  
  Enable sounds for actions in Medium.

- **Controller vibration**
  
  Vibrate the controllers to alert the artist to certain events (such as a successful save).

- **Avatar Hands**
  
  Display your Oculus Avatar hands in the scene. If not selected, only the tools are displayed.
Selecting a Hand

Define which hand is your Tool hand. Most users select their dominant hand (so if you’re right handed, select the right hand).

Exit Medium

To quit your sculpting session:

1. Press the yellow Control Panel button on the Support hand.
2. Select Exit Medium.
3. Select the green button (check mark) to exit, or the brown button (X) if you change your mind.
# Appendix A: Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Gesture</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Move Support hand thumbstick left.</td>
</tr>
<tr>
<td>Redo</td>
<td>Move Support hand thumbstick right.</td>
</tr>
<tr>
<td>Open Tool Tray</td>
<td>Push Support hand thumbstick away from you.</td>
</tr>
<tr>
<td>Swap Tool Mode</td>
<td>Double tap gear icon on Trigger hand.</td>
</tr>
<tr>
<td>alt-Tool (define)</td>
<td>1. Push the Support hand thumbstick away from you to open the Tool Tray.</td>
</tr>
<tr>
<td></td>
<td>2. While the Tool Tray is open, point to a tool, and squeeze the Support hand trigger to select it as the alt-tool. A pink triangle appears on the Tool Tray next to the selected tool, marking it as the alt-tool.</td>
</tr>
<tr>
<td>alt-Tool (select)</td>
<td>1. Squeeze and hold the Support hand trigger. (Note that the tool preview on the Tool hand changes to that of the selected alt-tool)</td>
</tr>
<tr>
<td></td>
<td>2. Use the Tool hand as you normally would.</td>
</tr>
<tr>
<td>Open Scene Graph</td>
<td>Pull Support hand thumbstick toward you.</td>
</tr>
<tr>
<td>Multi-select in Scene Graph</td>
<td>Squeeze the Support hand trigger, and while squeezing, select multiple elements with the Tool hand trigger.</td>
</tr>
<tr>
<td>Multi-select in scene</td>
<td>With the Scene Graph open, squeeze the Support hand trigger, and while squeezing, select multiple elements directly in the scene.</td>
</tr>
<tr>
<td>Open Control Panel</td>
<td>Tap the yellow Control Panel button on the Tool hand.</td>
</tr>
<tr>
<td>Tool settings</td>
<td>Tap the gear icon on the Tool hand.</td>
</tr>
<tr>
<td>Re-orient the tool to a stamp</td>
<td>1. Move the Tool hand thumbstick either right or left.</td>
</tr>
<tr>
<td></td>
<td>2. Reorient the tool to the stamp.</td>
</tr>
<tr>
<td></td>
<td>3. Release the thumbstick.</td>
</tr>
<tr>
<td>Select an element in the scene</td>
<td>1. Pull your Support hand thumbstick toward you.</td>
</tr>
<tr>
<td></td>
<td>2. Aim the Tool hand at the element and squeeze the tool hand trigger.</td>
</tr>
<tr>
<td>Transform an element in the scene by hand</td>
<td>Pull your Support hand thumbstick toward you, then aim the Tool hand at the element and squeeze the tool hand trigger. Once selected:</td>
</tr>
<tr>
<td></td>
<td>● Squeeze either grip button to move/rotate.</td>
</tr>
<tr>
<td></td>
<td>● Squeeze both grip buttons and move them together/apart to scale the element (if applicable).</td>
</tr>
</tbody>
</table>